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DFR0339 Bluno Beetle

DFR0343 UHex Low-power Controller

DFR0355 SIM808 with Leonardo
mainboard

DFR0392 DFRduino M0 Mainboard
Arduino Compatible

DFR0398 Romeo BLE Quad Robot
Controller

DFR0416 Bluno M0 Mainboard
DFRO0575 Beetle ESP32
DFRO0133 X-Board

DFR0162 X-Board V2

DFR0428 3.5 inches TFT Touchscreen
for Raspberry Pi

DFR0494 Raspberry Pi UPS HAT

DFR0514 DFR0603 IIC 16X2 RGB
LCD KeyPad HAT V1.0

DFR0524 5.5 HDMI OLED-Display
with Capacitive Touchscreen V2.0
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Introduction

Beetle ESP32-C3, mainly intended for loT applications, is a
controller based on ESP32-C3 RISC-V 32bit single-core
processor.

On a coin-size board of 25*20.5 mm, there are up to 13 10
ports broken out, so you don't have to worry about running
out of IO ports when making projects. Meanwhile, li-ion
battery charging management function is integrated on the
board which allows to directly connect li-ion battery without
extra modules, while ensuring the application size and safety.
The equipped expansion board for Beetle ESP32-C3 brings
out more power sources without increasing product volume,
more convenient to solder. Besides, the onboard easy-to-
connect GDI saves the trouble of wiring when using a screen.
Beetle ESP32-C3 supports WiFi and Bluetooth 5(LE) dual-
mode communication that reduces the difficulty of
networking, and also both Bluetooth Mesh protocol and
Espressif WiFi Mesh are supported for more stable
communication and a larger coverage area.

Detailed tutorials for Beetle ESP32-C3 are provided for users
to use the controller's WiFi function, such as connecting to
loT platforms like Aliyun, or IFTTT, etc. Or users can use
various sensors and actuators from DFRobot to build up loT
systems.

Beetle ESP32-C3 can be programmed by Arduino IDE, ESP-
IDF, MicroPython, C and Python are both supported.

2. Features

o Ultra-small size, the size is only 25x20.5mm(0.98x0.81
inch)

e Onboard lithium battery charging management,
charging and discharging is safer

e The matching bottom plate makes it more convenient to
make projects and use the screen

e RISC-V 32-bit core

e Supports Wi-Fi and Bluetooth 5 (LE) dual-mode
communication

3. Specification
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DFRO0550 5" TFT-Display with
Touchscreen V1.0

DFRO0591 raspberry pi e-ink display
module V1.0

DFR0592 DC Motor Driver HAT

DFR0604 I O Expansion HAT for Pi
zero V1.0

DFR0566 10 Expansion HAT for
Raspberry Pi

DFR0528 UPS HAT for Raspberry Pi
Zero

DFR0331 Romeo for Edison Controller

DFR0453 DFRobot CurieNano - A mini
Genuino Arduino 101 Board

TELO0110 CurieCore intel® Curie
Neuron Module

DFRO0478 FireBeetle ESP32 IOT
Microcontroller(V3.0) Supports Wi-Fi
& Bluetooth

DFR0483 FireBeetle Covers-Gravity [
O Expansion Shield

FireBeetle Covers-24x8 LED Matrix

TELO0121 FireBeetle Covers-LoRa
Radio 433MHz

TELO0122 FireBeetle Covers-LoRa
Radio 915MHz

TELO0125 FireBeetle Covers LoRa
Radio 868MHz

DFR0489 FireBeetle ESP8266 10T
Microcontroller

DFR0492 FireBeetle Board-328P with
BLEA4.1

DFR0498 FireBeetle Covers-
Camera&Audio Media Board

DFR0507 FireBeetle Covers-
OLED12864 Display

DFRO0508 FireBeetle Covers-DC Motor
& Stepper Driver

DFRO511 FireBeetle Covers-ePaper
Black&White Display Module

DFRO0531 FireBeetle Covers-ePaper
Black&White&Red Display Module

DFR0536 Micro bit Gamepad
Expansion Board

DFR0548 Micro bit Driver Expansion
Board

RORN1AR microsNs -
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parameters

e Operating voltage: 3.3V

e Type-Cinput voltage: 5V DC

e VIN input voltage: 5V DC

e Working current: 25mA

e Maximum charging current: 400mA

e Working temperature: -40~105°C

e Module size: 25x20.5 mm(0.98*0.81 inch)

Hardware information

e Processor: 32-bit RISC-V single-core processor
e Main frequency: 160 MHz

e SRAM: 400KB

e ROM: 384KB

e Flash: 4MB

e RTC SRAM: 8KB

o Clock: External (32 kHz) crystal, built-in fast RC oscillator
clock 17.5 MHz (adjustable), and PLL clock

e USB: USB 2.0 up to 12Mbit/s
WIFI

e WIFI protocol: IEEE 802.11b/g/n

o WIF| bandwidth: 2.4 GHz band supports 20 MHz and 40
MHz bandwidth

e WIFI mode: Station mode, SoftAP mode, SoftAP+Station
mode and promiscuous mode

o WIFI frequency: 2.4GHz
e Frame Aggregation: TX/RX A-MPDU, TX/RX A-MSDU

Bluetooth

e Bluetooth protocol: Bluetooth 5, Bluetooth mesh

e Bluetooth frequency: 125 Kbps, 500 Kbps, 1 Mbps, 2
Mbps

Interface pins

e Digital I/O x13
e LED PWM controller with 6 channels
e SPIx1
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ROBO0150 Micro bit Circular RGB LED
Expansion Board

MBTO0005 micro I0-BOX

SEN0159 CO2 Sensor

DFR0049 DFRobot Gas Sensor
TOY0058 Barometric Pressure Sensor

SEN0220 Infrared CO2 Sensor 0-
50000ppm

SEN0219 Gravity Infrared CO2 Sensor
For Arduino

SEN0226 Gravity [2C BMP280
Barometer Sensor

SENO0231 Gravity HCHO Sensor

SEN0251 Gravity BMP280 Barometric
Pressure Sensors

SENO0132 Carbon Monoxide Gas
Sensor MQ7

SENO0032 Triple Axis Accelerometer
Breakout - ADXL.345

DFRO0143 Triple Axis Accelerometer
MMA7361

Triple Axis Accelerometer FXLN83XX
Series

SEN0072 CMPSO09 - Tilt Compensated
Magnetic Compass

SENO0073 9 Degrees of Freedom -
Razor IMU

DFRO0188 Flymaple V1.1

SEN0224 Gravity 12C Triple Axis
Accelerometer - LIS2DH

SEN0140 10 DOF Mems IMU Sensor
V2.0

SEN0250 Gravity BMI160 6-Axis
Inertial Motion Sensor

SEN0253 Gravity BNOO055 + BMP280
intelligent I0DOF AHRS

SEN0001 URM37 V5.0 Ultrasonic
Sensor

SEN0002 URMO04 V2.0

SEN0004 SRF01 Ultrasonic sensor
SENO0005 SRF02 Ultrasonic sensor
SEN0006 SRF05 Ultrasonic sensor
SEN0007 SRFO08 Ultrasonic Sensor

SEN0008 SRF10 Ultrasonic sensor
Downloaded from Arrow.com.

UART x2
12C x1
12S x1

Infrared receiver and transmitter: transmit channel x2,

receive channel x2, (any pin)

2 x 12-bit SAR A/D converters, 6 channels

DMA controller, 3 receive channels and 3 transmit

channels

4. Schematic diagram of functional
pins

Function Instructions

Type-C: 5V
10/LED: Onboard LED pin

ESP32-C3 module: the latest ESP32-C3 module
launched by Espressif

TP4057

18Pin-FPC

Expansion Board

RST: reset pin, short contact point trigger reset

TP4057: TP4057 lithium battery charge management

chip

Charge: charging indicator

o Off: not plugged in power supply or fully charged

o On: charging
o Blinking: battery not connected
18Pin-FPC:GDI display interface

Pin Diagram

CEB v
[roc i) D
aC1_+ QSEKD)
aDEDa —— e
1100 ’ sissouas>s I oD

Pin Overview

GPIO: regular pins

Analog Port: Analog Input Pin
JTAG: Debug Interface

ADC: analog-to-digital conversion
VIN: 5V power input

BAT: battery access port

GDI display interface
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SEN0149 URMO06-RS485 Ultrasonic
SENO0150 URMO06-UART Ultrasonic
SENO0151 URMO06-PULSE Ultrasonic

SEN0152 URMO06-ANALOG
Ultrasonic

SENO0153 URMO07-UART Ultrasonic
Sensor

SEN0246 URMO08-RS485 Waterproof
Sonar Range Finder

SEN0304 URMO09 Ultrasonic Sensor
(Gravity-12C) (V1.0)

SEN0304 URMO09 Ultrasonic Sensor
(Gravity-12C) (V1.0)

- - -
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SEN0300 Water-proof Ultrasonic This interface is a dedicated GDI display interface for DFRbot.
Sensor ULS It is connected with an 18pin-FPC cable, and a single core

wire is used to connect the screen, providing you with the
SEN0301 Water-proof Ultrasonic

easiest way to use the screen. Below is a list of pins used by
Sensor ULA

the GDI interface.

SEN0307 URMO9 Ultrasonic Sensor
Gravity Analog

Beetle ESP32

FPC PINS . Description
C3 Pins
SENO0311 A02YYUW Waterproof
Ultrasonic Sensor VCC 3v3 3.3V
219 QW o BLK (PWM
SEN0312 MEO07YS Waterproof . ( . 10 Backlight
Ultrasonic Sensor dimming)
SEN0313 AOINYUB Waterproof GND GND GND
Ultrasonic Sensor
SCLK 4/SCK SPI clock
DFR0066 SHT 1x Humidity and
o N Host output,
Temperature Sensor MOSI 6/MOSI )
slave input
DFR0067 DHT11 Temperature and .
B F e (Yrrrmen Host input, slave
Humidity Sensor MISO 5/MISO
output
SEN0137 DHT22 Temperature and
humidity module bC 1 Data/command
DFR0023 DFRobot LM35 Linear RES 2 Reset
Temperature Sensor cs 7 TFT Chip Select
SDCS 0
Temper imue Sensor Arduino ol
Compatible V2
FCS NC Font library

DFR0024 Gravity DS18B20
Temperature Sensor Arduino TCS 3 Touch
Compatible V2

SCL 22/SCL 12C clock
SENO0114 Moisture Sensor

SDA 21/SDA [2C data
TOY0045 TMP100 Temperature
Sensor INT NC INT
TOY0054 SI7021 Temperature and IR AS ripstop pins
humidity sensor X1 NC custom pin 1
SEN0206 IR Thermometer Sensor X2 NC custom pin 2

MLX90614

Downloaded from AFfOW.com.
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SEN0227 SHT20 [2C Temperature &
Humidity Sensor Waterproof Probe

SEN0236 Gravity [2C BME280
Environmental Sensor Temperature,
Humidity, Barometer

SEN0248 Gravity [2C BME680

Environmental Sensor VOC,
Temperature, Humidity, Barometer

DFRO0558 Gravity Digital High
Temperature Sensor K-type

SEN0308 Waterproof Capacitive Soil
Moisture Sensor

SENO0019 Adjustable Infrared Sensor
Switch

SEN0042 DFRobot Infrared sensor
breakout

SEN0143 SHARP GP2Y0A41SKOF
IR ranger sensor 4-30cm

SEN0013 Sharp GP2Y0A02YK IR
ranger sensor 150cm

SEN0014 Sharp GP2Y0A21 Distance
Sensor 10-80cm

SEN0085 Sharp GP2Y0A710K
Distance Sensor 100-550cm

DFR0094 Digital IR Receiver Module

DFR0095 DIGITAL IR Transmitter
Module

SEN0018 Digital Infrared motion sensor
DFRO0107 IR Kit

SEN0264 TSO01 IR Thermal Sensor (4-
20mA)

SENO0169 Analog pH Meter Pro

DFR0300-H Gravity: Analog Electrical
Conductivity Sensor(K=10)

DFR0300 Gravity Analog Electrical
Conductivity Sensor Meter V2 K=1

SENO0165 Analog ORP Meter

SEN0161-V2 Gravity Analog pH
Sensor Meter Kit V2

SENO161 PH meter

SEN0237 Gravity Analog Dis
Oxygen Sensor

SEN0204 Non-contact Liquid Level
Sensor XKC-Y25-T12V

SEN0205 Liquid Level Sensor-FS-IR02

SEN0244 Gravity Analog TDS Sensor
Downloaded from AFfOW.COm.

When using FPC to link the screen, you can configure the
corresponding pin numbers according to the GDL demo.
Normally, you only need to configure three pins according to
different masters. Displays that support GDI:

o 1.54" 240x240 IPS wide viewing angle TFT display
e 1.8" 128x160 IPS TFT LCD Display

e 2.0" 320x240 IPS wide viewing angle TFT display
e 28" 320x240 IPS TFT resistive touch display

e 3.5"480x320 IPS TFT capacitive touch display

e 1.51" OLED Transparent Display with Converter

5. The first time to use

5.1 Arduino Environment Config

If you use Beetle-ESP32-C3 for the first time, you need to
know the following steps

. Add the json link in the IDE
. Download the core of the MCU

1
2
3. Select the development board and serial port
4. Open the sample code and burn it

5

. Get to know the serial monitor
e Arduino IDE compiler environment config
e Configure URL to the Arduino IDE

e Open Arduino IDE and click File->Preferences, as
shown below.

{m"n\ Blink | Arduino 1.80

au Sketch Tools Help

New cerl+N
Open... cerl+0
Open Recent >

Sketchbook 3
Eramples v
Close Crl+W

Save Ctrl+S

Save As... Ctrl+Shift+S

Page Setup  Ctrl+Shift+P
Print Ctrl+P

Preferences  Ctrl+Comma

Quit Ctrl+Q

1
1
15
It
17
18
19

esst or power the board

ialize digital pin LED_BUILTIN as an sutput
27 pinMode (CED_BUILTIN, OVTFUT);
2}

o In the newly opened interface, click the button in the red
circle as shown below

Englizh (Englich) v | (requires restart of Arduino)

[ Check for updates on startup ave vhen verifying or uploading

[JUse accessibility features

itional Boards Manager URLs: 2
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SEN0249 Gravity Analog Spear Tip pH
Sensor Meter Kit For Soil And Food
Applications

SENO0121 Steam Sensor

SEN0097 Light Sensor

DFR0026 DFRobot Ambient Light
Sensor

TOY0044 UV Sensor
SENO0172 LX1972 ambient light sensor

SEN0043 TEMT6000 ambient light
sensor

SENO0175 UV Sensor v1.0-ML8511

SEN0228 Gravity 12C VEML7700
Ambient Light Sensor

SEN0101 TCS3200 Color Sensor
DFR0022 DFRobot Grayscale Sensor

SENO0017 Line Tracking Sensor for
Arduino V4

SENO0147 Smart Grayscale sensor

SEN0212 TCS34725 12C Color Sensor
For Arduino

SEN0245 Gravity VL53L0X ToF Laser
Range Finder

SEN0259 TF Mini LiDAR ToF Laser
Range Sensor

SENO0214 20A Current Sensor
SEN0262 Gravity Analog Current to
Voltage Converter for 4~20mA

Application

SEN0291 Gravity: [2C Digital
Wattmeter

DFR0027 DFRobot Digital Vibration
Sensor V2

DFR0028 DFRobot Tilt Sensor
DFR0029 DFRobot Digital Push Button

DFR0030 DFRobot Capacitive Touch
Sensor

DFR0032 Digital Buzzer Module

DFR0033 Digital magnetic se!

DFR0034 Analog Sound Sensor

Downloaded from AFfOW.com.

Copy the following link into the new pop-up dialog
box:https://raw.githubusercontent.com/espressif/arduin
0-esp32/gh-pages/package_esp32_index.json

Note: If you have installed another environment before,
you can press Enter key at the beginning or end of the
previous link and paste the link into any line.

Additional Boards Manager URLs x
g

Enter additional TRLs, ome for each ros

nttps://raw.gichubusercontent.com/espressif/arduino-esp32/gh-pages/package esp32 dev_index.jsonm |
http://download. dfzobot. top/FizeBeetle /package_DFRobot_index.jsom

Click for a list of wnofficisl hoards support URLs

Click OK
Update the board

Open Tools->Board:->Boards Manager... as shown
below:

® Blink | Arduino 180 [E=EE )

Fie £de Sketo(Tasis) Help
00 BN culeT [5]
=
Bink S -

CorlyshiferM
CrrlashifeiL

ino Zero (Programming Port)"

rdinalSP.org"

Boards Manager will automatically update the boards as
shown below:

& Boards Manager ===

Type [M1

1.6.17 INSTALLED E

uino Una WiFi, Ard

Arduino SAMD Boards (32-bits ARM Cortex-M0+) by Arduina version 1.6.2 INSTALLED

uino MKR1000, Arduine MKRZero, Arduino MKRFox1200, Arduino MO Pro, Arduino M0, Arduino

[ Townlosding platF fox

i Cancsl

o After completing the update, you can enter esp32 at the

top, select esp32 and click install when the following
occurs (current version is 2.0.0):

@ Boards Manager X
Type [ALL | [espaz
DFRobot ESP32 Boards ~
by bot version 0.2.1 INSTALLED
o dec

e Wait for the end of the following progress bar:



https://raw.githubusercontent.com/espressif/arduino-esp32/gh-pages/package_esp32_index.json
http://www.arrow.com

SEN0038 Wheel Encoders for

@ Boards Manager x
DFR 3PA and 4WD Rovers e 5T —
DFRobot ESP32 Boards "
.. by DFRobot version (.).1.1 INSTALLED
DFRO0051 Analog Voltage Divider o e

More Info

DFR0052 Analog Piezo Disk Vibration e

by Esprassif Systams

Sensor o b i o B R T
More Info
Installing ..
DFRO0076 Flame sensor
DFR0053 Analog Slide Position Sensor | | 2
[ Verifying archive integrity Caneel

DFR0054 Analog Rotation Sensor V1 . . . . .
e After completing the installation, the list will show that

DFR0058 Analog Rotation Sensor V2 the esp32 has been installed, as shown below:
P . . @ Boards Manager X
DFRO0061 Joystick Module For Arduino o S

by DFRabot varsion 0.2.1 INSTALLED
DFR0075 ADKeyboard Module e e e e R

More Info

DFR0332 Fan Module =
by Espressif Systems version 2.0.0 INSTALLED |

Baards included in this package:
ESP32 Dev Module, WEMOS LoLin32, WEMOS D1 MINI ESP32.
More Info

SENO0177 PM2.5 laser dust sensor

Select version v || Install Remove

SEN0160 Weight Sensor Module

SEN0170 Wind Speed Sensor Voltage o
Type 0-5V

e Click Tools->Board: select ESP32C3 Dev Module (usually

TOY0048 High Accuracy Dual Axis the first in the list)
Inclinometer Sensor Arduino Gadgeteer
Compatible

- _

Cul+shiftsl
Culashiftim

SEN0187 RGB and Gesture Sensor sl P

WFI101 / WIFININA Firmware Updater

> . X Upload Speed: 921600 (2] 3 Arduino ARM (32-bits) Boards ;
SENO0186 Weather Station with T e ———
) ; et | | e ] B
Anemometer Wind vane Rain bucket . | ometer s s | Ereme
| [vinii O | s
R !

me: “Default 4MB with spiffs (12MB APP/1.5MB SPIFFS)" 1 Intel Curie (32:bi0 Boards
Core Debug Level: "Nore™ >

SEN0192 MicroWave Sensor > e

Get Board Info UM Feathers2 Neo
Programmer > UM Tinys2
Bum Bootload:

SENO0185 Hall sensor

FIT0449 DFRobot Speaker v1.0 ° Bef?re starting, you need tg configure the following
settings (when you select Disabled, the serial port is
SEN0203 Heart Rate Sensor RX(20), TX(21), if you need to print on the Arduino

monitor via USB, you need to select Enable)

DFR0423 Self-Locking Swicth

@ Blink | Arduing 1.815
File Edit Sketch Tools Help

SENO0213 Heart Rate Monitor Sensor 90 BH ek o
Blink Fix Encoding & Reload

. Manage Libraries... Ctrl+Shift+1
SENO0221 Gravity Hall Angle Sensor Serial Mritor CulsShifee
Serial Plotter Ctrl+Shift+L

) L. . WiFi101 / WiFININA Firmware Updater
SEN0223 Conductivity Switch Sensor e Bt >
Upload Speed: *921600" >
o | Disabled
SEN0230 Incremental Photoelectric IR o

CPU Frequency: "160MHz (WiFi)" >
ROtﬁl'y Encoder - 400P R Flash Frequency: "80MHz" >

Flash Mode: *QIO* >

SENO0235 EC11 Rotary Encoder

o Click Port to select the corresponding serial port
Module

Downloaded from AFfOW.com.
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SEN0240 Analog EMG Sensor by
OYMotion

SEN0232 Gravity Analog Sound Level
Meter

SEN0233 Air Quality Monitor PM 2.5,
Formaldehyde, Temperature & Humidity

Sensor

DFRO515 FireBeetle Covers-OSD
Character Overlay Module

SEN0257 Gravity Water Pressure
Sensor

SEN0289 Gravity: Digital Shake Sensor
SEN0290 Gravity: Lightning Sensor
DFR0271 GMR Board

ROBO0003 Pirate 4WD Mobile Platform
ROBO0005 Turtle 2WD Mobile Platform

ROB0025 NEW A4WD Mobile Robot
with encoder

ROB0050 4WD MiniQ Complete Kit
ROBO0111 4WD MiniQ Cherokey
ROB0036 6 DOF Robotic Arm Kit
FIT0045 DF0SBB Tilt Pan Kit

ROB0102 Cherokey 4WD Mobile
Platform

ROBO0117 Basic Kit for Cherokey 4WD
ROB0022 4WD Mobile Platform
ROBO0118 Basic Kit for Turtle 2WD
ROB0080 Hexapod Robot Kit

ROBO0112 Devastator Tank Mobile
Platform

ROBO0114 Devastator Tank Mobile
Platform

ROB0124 HCR Mobile Platform with
Omni Wheels

ROBO0128 Devastator Tank Mobile
Platform Metal DC Gear Motor

ROBO0137 Explorer MAX Robot
ROBO0139 FlameWheel Robot

DFR0270 Accessory Shield for Arduino

DFR0019 Prototyping Shield For
Arduino

DFR0265 10 Expansion Shield for

Arduino V7
Downloaded from Arrow.com.

© wiFiClient | Arduino 1.8.13 - o X

File Edit Sketch [Tools Help
OO0 BE et o]
WiFIClent -]
Culsshifes! -

Ctrl+Shift+M
CerlShift+L

WIFi101 / WIFININA Firmware Updater

Board: "ESP32C3 Dev Module” >
Upload Speed: *521600°
USB CDC On Boots “Disabled”
Upload Mode: *UARTO" >
‘ CPU Frequency: *160MHz (WiF)*
9 #INCLY  [ach Frequency: "80MHZ"

*4ME (32Mb)*

*Default 4MB with spiffs (1.2M8 APP/1.5MB SPIFFS)"

Core Debug Level: "None" >

Port: "COM17 (ESP32C3 Dev Module)* i Serial ports

Get Board Info ¥ COMI7 (ESP32C3 Dev Module)

Programmer

Bur Bootloader

18 void setup()

198 {
Serial.begin(115200);
delay (10) 7

5.2 LED Blink

Onboard LED is default to pin 10

Code

int led = 10;

void setup() {
pinMode(led,OUTPUT);

}

void loop() {
digitalWrite(led,HIGH);
delay(1000);
digitalWrite(led,LOW);
delay(1000);

}

e Paste the above program into the program box

o Click the arrow to wait for the program to be compiled
and burn it to the development board

Burn succeeded

e As shown above, burn succeeded.
e You will see the onboard LED blink.

o Can't burn? Click here.

6. Basic Tutorial (Introduce the
difference between Arduino)

o \Want to learn about Arduino basics? Click here.

6.1 PWM Output

The PWM function of ESP32C3 needs to be declared
in advance.

e |edcAttachPin(GPIO, Channel)

Description: specify which GPIO the signal will appear
on

Parameter:

o GPIO: GPIO to output the signal

o Channel: GPIO where the signal will be generated
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DFRO0210 Bees Shield

DFRO0165 Mega IO Expansion Shield
V23

DFRO0312 Raspberry Pi GPIO Extension
Board

DFRO0311 Raspberry Pi Meet Arduino
Shield

DFR0327 Arduino Shield for Raspberry
Pi2B and 3B

DFR0371 IO Expansion Shield for
Bluno M3

DFR0356 Bluno Beetle Shield

DFR0412 Gravity 10 Expansion Shield
For DFRduino MO

DFR0375 Cookie I O Expansion Shield
V2

DFR0334 GPIO Shield for Arduino
V1.0

DFRO0502 Gravity IO Expansion &
Motor Driver Shield V1.1

DFR0518 Micro Mate- A Mini
Expansion Board for micro bit

DFR0578 Gravity I O Expansion Shield
for OpenMV Cam M7

DFRO0577 Gravity I O Expansion Shield
for Pyboard

DFR0626 MCP23017 IIC to 16 digital
IO expansion module

DFR0287 LCD12864 Shield

DFR0009 LCD KeyPad Shield For
Arduino

DFR0063 [12C TWI LCD1602 Module
Gadgeteer Compatible

DFRO154 I2C TWI LCD2004 Module
Arduino Gadgeteer Compatible

DFR0202 RGB LED Matrix
DFR0090 3-Wire LED Module

TOYO0005 OLED 2828 color display
module .NET Gadgeteer Compatible

TOY0006 OLED 9664 RGB Display
module

TOY0007 OLED 2864 display module

FIT0328 2.7 OLED 12864 display
module

DFR0091 3-wire Serial LCD Module
Arduino Compatible

Downloaded from Arfow.com.

o |edcWrite(Channel, dutyCycle)
Description: set the PWM signal generation channel
Parameter:

o Channel: signal generation channel

o dutyCycle: PWM value
e |edcSetup(Channel, freq, resolution)
Description: set the PWM signal generation channel
Parameter:

o LedChannel: signal generation channel
o freq: PWM frequency

o resolution: PWM resolution

Sample

The ESPC3 PWM can be freely mapped to other ports for
output, you need to set it up. This sample will be used to help
you understand the operation steps, and you can see the LED
gradually brighten and dim through it.

/*

* LED breathing light sample

*/

const int ledPin = 1@0; // Actually output pin afte

//Set PWM parameter

const int freq = 5000;//PWM frequency

const int ledChannel = ©0;//GPIO for signal generati
const int resolution = 8;//8-bit resolution

void setup(){
//PWM parameter setting
ledcSetup(ledChannel, freq, resolution);

//Attach the signal generation channel to the out
ledcAttachPin(ledPin, ledChannel);

}

void loop(){
//Start to brighten
for(int dutyCycle = 0; dutyCycle <= 255; dutyCycl
// changing the LED brightness with PWM
ledcWrite(ledChannel, dutyCycle);
delay(15);
}

//Start to dim
for(int dutyCycle = 255; dutyCycle >= 0; dutyCycl
// changing the LED brightness with PWM
ledcWrite(ledChannel, dutyCycle);
delay(15);
¥
}

J | i

6.2 Interrupt

ESP32C3 interrupts can be freely assigned

e pinMode(GPIO,INPUT_PULLUP);
Description: external interrupt pin definition
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DFR0347 2.8 TFT Touch Shield with
4MB Flash for Arduino and mbed

DFRO0348 3.5 TFT Touch Shield with
4MB Flash for Arduino and mbed

DFR0374 LCD Keypad Shield V2.0
DFR0382 LED Keypad Shield V1.0

DFR0387 TELEMATICS 3.5 TFT
Touch LCD Shield

DFR0459 8x8 RGB LED Matrix

DFR0460 64x32 RGB LED Matrix -
4mm Pitch/64x32 Flexible RGB LED
Matrix-4mm Pitch/64x32 Flexible RGB
LED Matrix-5Smm Pitch

DFRO0461 Gravity Flexible 8x8 RGB
LED Matrix

DFR0462 Gravity Flexible 8x32 RGB
LED Matrix

DFR0463 Gravity Flexible 16x16 RGB
LED Matrix

DFR0471 32x16 RGB LED Matrix -
6mm pitch

DFR0472 32x32 RGB LED Matrix -
4mm pitch

DFR0464 Gravity I2C 16x2 Arduino
LCD with RGB Backlight Display

DFR0499 64x64 RGB LED Matrix -
3mm pitch

DFR0506 7" HDMI Display with
Capacitive Touchscreen

DFRO555\DF0556\DFR0557 Gravity
[2C LCD1602 Arduino LCD Display
Module

DFR0529 2.2 inches TFT LCD Display
V1.0 (SPI Interface)

DFR0605 Gravity: Digital RGB LED
Module

FIT0352 Digital RGB LED
Weatherproof Strip 60LED m*3m

DFR0645-G DFR0645-R 4-Digital
LED Segment Display Module

SKU DFR0646-G DFR0646-R 8-
Digital LED Segment Display Module

DFR0597 7x71 Flexible RGB LED
Matrix

DFR0231 NFC Module for Arduino
TEL0005 APC220 Radio Data Module

TEL0023 BLUETOOH BEE
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Parameters:

o GPIO: the pin that ESP32C3 is to use as an interrupt.
o INPUT_PULLINGUP: set pull-up mode.

e attachinterrupt(digitalPinTolnterrupt(pin), ISR,

mode)
Description: External interrupts
Parameters:

o pin: the Arduino pin number.

o ISR: the ISR to call when the interrupt occurs; this
function must take no parameters and return
nothing. This function is sometimes referred to as
an interrupt service routine.

o mode: defines when the interrupt should be
triggered. Three constants are predefined as valid
values.

o CHANGE trigger the interrupt pin when the pin level
changes

o RISING trigger the interrupt pin when the pin level
changes from low to high

o FALLING Trigger the interrupt pin when the pin level
changes from high to low

e detachlinterrupt(digitalPinTolnterrupt(pin))

Description: Turn off the given interrupt.
Parameters:

o pin: the interrupt pin to be disabled

Interrupts ()

Description: Re-enables interrupts (after they've been
disabled by nolnterrupts(). Interrupts allow certain
important tasks to happen in the background and are
enabled by default. Some functions will not work while
interrupts are disabled, and incoming communication
may be ignored. Interrupts can slightly disrupt the
timing of code, however, and may be disabled for
particularly critical sections of code.

nolnterrupts ()

Description: Disables interrupts (you can re-enable
them with interrupts()). Interrupts allow certain
important tasks to happen in the background and are
enabled by default. Some functions will not work while
interrupts are disabled, and incoming communication
may be ignored. Interrupts can slightly disrupt the
timing of code, however, and may be disabled for
particularly critical sections of code.

6.3 Setial Port

ESP32C3 serial port initialization requires mapping

e Seriall.begin(baud, config, rxPin, txPin);

Description: Serial1 initialization
Parameters:
o baud: baud rate

o config: data bit and stop bit setting
o rxPin: RX pin
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TEL0026 DF-BluetoothV3 Bluetooth
module

TEL0037 Wireless Programming
Module For Arduino

TEL0044 DFRduino GPS Shield-LEA-
SH

TELO0047 WiFi Shield V2.1 For Arduino

TEL0051 GPS GPRS GSM Module
V2.0

TEL0067 WiFi Bee V1.0
TEL0073 BLE-Link
TELO0075 RF Shield 315SMHz

TELO0078 WIFI Shield V3 PCB
Antenna

TELO0079 WIFI Shield V3 RPSMA
TEL0084 BLEmicro
TEL0086 DF-Beacon EVB

TEL0087 USBBLE-LINK Bluno
Wireless Programming Adapter

TEL0080 UHF RFID MODULE-USB

TEL0081 UHF RFID MODULE-
RS485

TEL0082 UHF RFID MODULE-
UART

TELO0083-A GPS Receiver for Arduino
Model A

TEL0092 WiFi Bee-ESP8266 Wirelss
module

TEL0094 GPS Module With Enclosure

TEL0097 SIM808 GPS GPRS GSM
Shield

DFR0342 W5500 Ethernet with POE
Mainboard

DFRO0015 Xbee Shield For Arduino no
Xbee

TELO0107 WiFiBee-MT7681 Arduino
WiFi Wireless Programming

TEL0089 SIM800C GSM GPRS Shield
V2.0

TELO0112 Gravity 315MHZ RF Receiver
Module

TELO0113 Gravity UART A6 GSM &
GPRS Module
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o txPin: TX pin

Seriall.begin(9600,SERIAL_8N1,/*rx =*/0,/*Tx =*/1);

dl | B

6.4 Servo

ESP32-C3 doesn't support driving servo through the Servo
library. Please search and install the ESP32_ISR_Servo
library in Sketch->Include Library->Manage Library to
drive servo.

7. Advanced Tutorial

7.1 Use SD Library

SD Class

e begin(cspin)
Description: Initializes the SD library and card. This
begins use of the SPI bus (digital pins 11, 12, and 13 on
most Arduino boards; 50, 51, and 52 on the Mega) and
the chip select pin, which defaults to the hardware SS
pin (pin 10 on most Arduino boards, 53 on the Mega).
Note that even if you use a different chip select pin, the
hardware SS pin must be kept as an output or the SD
library functions will not work.
Parameter:

o cspin:the Arduino pin connected to the chip select
line of the SD card.

Return: boolean type. True on success; false on failure

® exists()
Description: Test whether a file or directory exists on
the SD card.
Syntax: SD. exists( filename)
Parameter:

o filename: the name of the file to test for existence,
which can include directories (delimited by
forward-slashes, /)

Return: boolean type, true if the file or directory exists,
false if not

e open()
Description: Opens a file on the SD card. If the file is
opened for writing, it will be created if it doesn't already
exist (but the directory containing it must already exist).
Syntax: SD.open( filename) SD.open(filename, mode)
Parameter:

o filename: the name the file to open, which can
include directories (delimited by forward slashes, /)
mode (optional): the mode in which to open the file,
defaults to FILE_READ - byte. one of:

o FILE_READ: open the file for reading;

o FILE_WRITE: open the file for reading and writing.
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TELO0118 Gravity UART OBLOQ IoT
Module

TELO0120 DFRobot BLE4.1 Module
TEL0002 Bluetooth Adapter

TELO108 Bluetooth Audio Receiver
Module

TEL0124 SIM7600CE-T 4G(LTE)
Shield V1.0

DFR0505 SIM7000C Arduino NB-IoT
LTE GPRS Expansion Shield

DFRO0013 IIC to GPIO Shield V2.0

DFRO0057 Sensor Motor Drive Board -
Version 2.2

DFR0062 WiiChuck Adapter
DFR0233 RS485 Sensor Node V1.0
DFR0259 Arduino RS485 Shield
DFR0370 CAN-BUS Shield V2
DFR0627 IIC to dual UART module

TEL0070 Multi USB RS232 RS485
TTL Converter

DFR0064 386 AMP audio amplifier
Module

DFR0273 Speech Synthesis Shield
DFR0299 DFPlayer Mini

TOY0008 DFRduino Player MP3
SENO0197 Voice Recorder-ISD1820

DFR0420 Audio Shield For DFRduino
MO

DFR0534 Voice Module

SD2403 Real time clock Module SKU
TOY0020

TOY0021 SD2405 Real time clock
Module

DFRO151 Gravity 12C DS1307 RTC
Module

DFR0469 Gravity 12C SD2405 RTC
Module

DFR0316 MCP3424 18-Bit ADC-4
Channel with Programmable Gain
Amplifier

DFRO0552 Gravity 12-Bit 12C DAC
Module

DFRO0553 Gravity I2C ADS1115 16-Bit
ADC Module Arduino & Raspberry Pi
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Return: a File object referring to the opened file: if the
file couldn't be opened, this object will evaluate to false
in a boolean FILE_WRITE: open the file for reading and
writing.

Return: a File object referring to the opened file;Return
false if the file cannot be opened.

e remove() Description: Remove a file from the SD card.
If the file didn't exist, the return value is unspecified, so it
is better to use SD. Exists (file name) to detect whether
the file exists before removing the file.

Syntax: SD. remove( filename)
Parameter:

o filename:the name of the file to remove, which can
include directories (delimited by forward-slashes, /)

Return: boolean type. True if the removal of the file
succeeded, false if not.

e mkdir(filename) Description: Create a directory on
the SD card.
Parameter:

o filename: the name of the directory to create, with
sub-directories separated by forward-slashes, /

Return: boolean type. True if the creation of the
directory succeeded, false if not.

e rmdir(filename) Description: Remove a directory
from the SD card. The directory must be empty.
Syntax: SD.rmdir( filename)

Parameter:

o filename: the name of the directory to remove, with
sub-directories separated by forward-slashes, /

Return: booleantype. True if the removal of the directory
succeeded, false if not.

File Class

The file class provides the function of reading/writing files.
The function of this class is very similar to the that of serial
port related functions used before. The member functions
are as follows.

e available()
Description: Check if there are any bytes available for
reading from the file.
Syntax: file. available()
Parameter:

o file:an instance of the File class
Return: the number of bytes available

e close()
Description: Close the file, and ensure that any data
written to it is physically saved to the SD card.
Syntax: file. close()
Parameter:

o file:an instance of the File class
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DFRO117 Gravity I2C EEPROM Data
Storage Module

DFR0071 SD Module

DFRO0057 Sensor Motor Drive Board -
Version 2.2

DFR0360 XSP - Arduino Programmer
DFRO0411 Gravity 130 DC Motor
DFR0438 Bright LED Module
DFR0439 LED String Lights Colorful
DFR0440 The Micro Vibration Module

DFR0448 LED String Lights Warmm
White

DFR0503 Embedded Thermal Printer -
TTL Serial

DFR0504 Gravity Analog Signal Isolator
DFRO0520 Dual Digital Pot 100K
DFR0565 Gravity Digital Signal Isolator

DFR0563 Gravity 3.7V Li Battery Fuel
Gauge

DFRO0576 Gravity Digital 1-to-8 12C
Multiplexer

DFRO117 Gravity 2C EEPROM Data
Storage Module

DRI0001 Arduino Motor Shield 1.293

DRI0002 MD1.3 2A Dual Motor
Controller

DRI0009 Arduino Motor Shield L298N

DRI0021 Veyron 2x25A Brush DC
Motor Driver

DRI0017 2A Motor Shield For Arduino
Twin

DRI0018 DC Motor Driver 2x15A Lite

FIT0450 Micro DC Motor with
Encoder-SJO1

FIT0458 Micro DC Motor with
Encoder-SJ02

DFR0399 DC Micro Metal Gear Motor
75 1 w Driver

DRI0039 Quad Motor Driver Shield for
Arduino

DRI0040 Dual 1.5A Motor Driver -
HR8833

DRI0044 2x1.2A DC Motor Driver
TB6612FNG
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Return: none

flush()

Description: Ensures that any bytes written to the file
are physically saved to the SD card. This is done
automatically when the file is closed.

Syntax: file.flush

Parameter:

o file: an instance of the File class
Return: none

peek()

Description: Read a byte from the file without
advancing to the next one.

Parameter:

o file: an instance of the File class

Return: The next byte (or character), or -1 if none is
available.

position( )

Description: Get the current position within the file (i.e.
the location to which the next byte will be read from or
written to).

Syntax: file. position()

Parameter:

o file: an instance of the File class

Return: the position within the file

print()

Description: Print data to the file, which must have
been opened for writing.

Syntax: file. print(data)file. print(data, BASE)
Parameter:

o file: an instance of the File class
o data:the data to print (char, byte, int, long, or string)

o BASE(optional): the base in which to print numbers:
BIN for binary (base 2), DEC for decimal (base 10),
OCT for octal (base 8), HEX for hexadecimal (base
16).

Return: byte number to be transmitted.

printin()

Description: Print data, followed by a carriage return
and newling, to the File, which must have been opened
for writing.

Syntax: file. printin(data)file,printin(data, BASE)
Parameter:

o file:an instance of the File class

o data (optional): the data to print (char, byte, int, long,
or string)

o BASE (optional): the base in which to print numbers:
BIN for binary (base 2), DEC for decimal (base 10),
OCT for octal (base 8), HEX for hexadecimal (base
16).
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DFRO0513 PPM 2x3A DC Motor Driver

DFR0523 Gravity Digital Peristaltic
Pump

DRI0027 Digital Servo Shield for
Arduino

DRI0029 Veyron Servo Driver 24-
Channel

SER0044 DSS-M15S 270° 15KG DF
Metal Servo with Analog Feedback

DRI0023 Stepper Motor Shield For
Arduino DRV§825

DRI0035 TMC260 Stepper Motor
Driver Shield

DFRO0105 Power Shield
DFR0205 Power Module

DFR0457 Gravity MOSFET Power
Controller

DFR0564 USB Charger for 7.4V LiPo
Battery

DFR0535 Solar Power Manager

DFR0559 Sunflower Solar Power
Manager 5V

DFR0559 Solar Power Manager SV

DFR0580 Solar Power Manager For
12V Lead-Acid Battery

DFR0222 X-Board Relay

DFR0017 Relay Module Arduino
Compatible

DFR0289 RLY-8-POE Relay Controller

DFR0290 RLY-8-RS485 8 Relay
Controller

DFR0144 Relay Shield for Arduino
V2.1

DFR0473 Gravity Digital Relay Module
Arduino & Raspberry Pi Compatible

KIT0003 EcoDuino - An Auto Plant Kit

KIT0071 MiniQ Discovery Kit

KIT0098 Breadboard Plugin
Components Pack

SKU DFR0748 Kitty Flower

SEN0305 Gravity: HUSKYLENS - An
Easy-to-use Al Machine Vision Sensor

Sensor connection to Raspberry Pi

DFR0677 ONPOWER UPS HAT for
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Return: byte number to be transmitted.

seek()

Description: Seek to a new position in the file, which
must be between 0 and the size of the file (inclusive).
Syntax: file. seek( pos)

Parameter:

o file:an instance of the File class

o pos: the position to which to seek
Return: true for success, false for failure (boolean)

size()

Description: Get the size of the file.
Syntax: filue. size()

Parameter:

o file:an instance of the File class
Return: the size of the file in bytes

read()
Description:Read from the file.
Syntax: file.read Parameter:

o file:an instance of the File class

Return: The next byte (or character), or -1 if none is
available.

e write()

Description: Write data to the file.
Syntax: file. write(data)file. write(buf, len)
Parameter:

file:an instance of the File class

s}

o

data:the byte, char, or string (char*) to write

o

buf: an array of characters or bytes

o

len:the number of elements in buf
Return: the number of bytes written

isDirectory()
Description: Reports if the current file is a directory or
not

Syntax: file.isDirectory()
Parameter:

o file: an instance of the File class
Return:boolean. True if the file is a directory, false if not

openNextFile()

Description: Reports the next file or folder in a
directory.

Syntax: file.openNextFile()

Parameter:

o file: an instance of the File class that is a directory
Return: the next file or folder in the path

rewindDirectory()
Description: Back to the first file in the directory
Syntax: file.rewindDirectory()
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p

arameter:

o file: an instance of the File class.

Return: None

7.2 ESP32-C3 Bluetooth Receive and

Tran

7.2.1

smit

ESP32-C3 and mobile phone Bluetooth

communication

This example demonstrates the data transmission between

ESP32-C3 and the mobile phone. If you need to modify or

use the data, you only need to change the data receiving

part orthe data transmitting part of the code.

/*

*/

/*
*

*

*

*/

#in
#in
#in
#in

BLE
BLE
boo
uin

/7
/7

#de
#de
#de

//B
cla

Video: https://www.youtube.com/watch?v=0CMOYS71
Based on Neil Kolban example for IDF: https://g
Ported to Arduino ESP32 by Evandro Copercini

Create a BLE server that, once we receive a conn
The service advertises itself as: 6E400001-B5A3-
Has a characteristic of: 6E400002-B5A3-F393-EQAS
Has a characteristic of: 6E400003-B5A3-F393-EQAS

The design of creating the BLE server is:
Create a BLE Server
Create a BLE Service

Create a BLE Characteristic on the Service
Create a BLE Descriptor on the characteristic
Start the service.

Start advertising.

a v A W N R

This example demonstrates the transparent transn
1. You can see the data sent by ESP32-C3--see AF
2. Data can be sent to ESP32-C3 through the inpu
This example is changed from the BLE_uart exampl

clude <BLEDevice.h>
clude <BLEServer.h>
clude <BLEUtils.h>
clude <BLE2902.h>

Server *pServer = NULL;
Characteristic * pTxCharacteristic;
1 deviceConnected = false;

t8_t txValue = 0;

See the following for generating UUIDs:
https://www.uuidgenerator.net/

fine SERVICE_UUID "6E400001-B5A3-F393-
fine CHARACTERISTIC_UUID_RX "6E400002-B5A3-F393-
fine CHARACTERISTIC_UUID_TX "6E400003-B5A3-F393-

luetooth connect/disconnect processing. Triggere

ss MyServerCallbacks: public BLEServerCallbacks

void onConnect(BLEServer* pServer) { //This f
Serial.println("Bluetooth connected");
deviceConnected = true;

1

void onDisconnect(BLEServer* pServer) { //This
Serial.println("Bluetooth disconnected");
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deviceConnected = false;
delay(500); // give the bluetooth stack the c
pServer->startAdvertising(); // restart adver

}s

/****************Data receiving Section************
/****************************************/
//Bluetooth receive data processing. Triggered autc
class MyCallbacks: public BLECharacteristicCallback
void onWrite(BLECharacteristic *pCharacteristic
std::string rxValue = pCharacteristic->getVal

//if(rxvValue == "ON"){Serial.println("JFFXT");

if (rxValue.length() > 0) {

Serial.println("**krkkkkn) .

Serial.print("Received Value: ");

for (int i = ©; i < rxValue.length(); i++){
Serial.print(rxValue[i]);

}

Serial.println();

Serial.println("***xxkkxxn)

}s

/***************************************/

/****************************************/

void setup() {
Serial.begin(115200);
BLEBegin(); //Initialize Bluetooth

void loop() {
/****************Data tpansmitting Section*********
/****************************************/
if (deviceConnected) { //If there is a Bluetooth
pTxCharacteristic->setValue("Hello"); //Send s
pTxCharacteristic->notify();
delay(10); // bluetooth stack will go into cong

pTxCharacteristic->setValue("DFRobot"); //Senc

pTxCharacteristic->notify();

delay(10); // bluetooth stack will go into cong
¥

/****************************************/

/****************************************/

}

void BLEBegin(){
// Create the BLE Device
BLEDevice::init(/*BLE name*/"UART Service");

// Create the BLE Server
pServer = BLEDevice::createServer();
pServer->setCallbacks(new MyServerCallbacks());

// Create the BLE Service
BLEService *pService = pServer->createService(SER

// Create a BLE Characteristic

pTxCharacteristic = pService->createCharacteristi
CHARACTERISTIC_UUID_TX,
BLECharacteristic: :PROPERTY_NOT

);

pTxCharacteristic->addDescriptor(new BLE2902());
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BLECharacteristic * pRxCharacteristic = pService-
CHARACTERISTIC_UUID_RX,
BLECharacteristic: :PROPERTY_I

)
pRxCharacteristic->setCallbacks(new MyCallbacks()

// Start the service
pService->start();

// Start advertising
pServer->getAdvertising()->start();
Serial.println("Waiting a client connection to nc

}
J i
7.2.2 Two ESP32C3 Bluetooth Communication

Use this example to demonstrate the data transmission
between ESP32-C3 and ESP32-C3. If you need to modify or
use the data, you only need to change the data receiving
partorthe data transmitting part of the code.

Host code

/**
* A BLE client example that is rich in capabilitie
* There is a lot new capabilities implemented.
* author unknown
* updated by chegewara
*/

#include "BLEDevice.h"
//#include "BLEScan.h"

// The remote service we wish to connect to.

static BLEUUID serviceUUID("4fafc201-1fb5-459e-8fcc
// The characteristic of the remote service we are
static BLEUUID charTXUUID("beb5483e-36e1-4688-b7

static BLEUUID charRXUUID("beb5483f-36e1-4688-b7

static boolean doConnect = false;

static boolean connected = false;

static boolean doScan = false;

static BLERemoteCharacteristic* pTXRemoteCharacteri
static BLERemoteCharacteristic* pRXRemoteCharacteri
static BLEAdvertisedDevice* myDevice;

/****************Data receiving Section************
/****************************************/
//Bluetooth receive data processing, automatically
static void notifyCallback(BLERemoteCharacteristic*
String BLEData = "";
for(int i = @; i < length; i++) //
BLEData += (char)pData[i];
Serial.println( "okt o
Serial.print("Received Value: ");
Serial.println(BLEData);
Serial.println("*xkkkkkkkiy o

//if (BLEData == "ON"){Serial.println("Turn on t

//Serial.print("Notify callback for characteris
//Serial.print(pBLERemoteCharacteristic->getUUI
//Serial.print(" of data length ");
//Serial.println(length);

Downloaded from Arrow.com.
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/****************************************/

/****************************************/

//Bluetooth connect/disconnect handling. Triggered
class MyClientCallback : public BLEClientCallbacks
void onConnect(BLEClient* pclient) {
¥

void onDisconnect(BLEClient* pclient) {
connected = false;
Serial.println("onDisconnect");
}
s

/**
* Scan for BLE servers and find the first one that
*/
//Bluetooth scan processing event. Triggered autom
class MyAdvertisedDeviceCallbacks: public BLEAdvert
/**
* Called for each advertising BLE server.
*/
void onResult(BLEAdvertisedDevice advertisedDevic
//Serial.print("BLE Advertised Device found: ")
//Serial.println(advertisedDevice.toString().c_

// We have found a device, let us now see if it
if (advertisedDevice.haveServiceUUID() && adver
BLEDevice::getScan()->stop();
myDevice = new BLEAdvertisedDevice(advertisec
doConnect = true;
doScan = true;

} // Found our server
} // onResult
}; // MyAdvertisedDeviceCallbacks

void setup() {
Serial.begin(115200);
Serial.println("Starting Arduino BLE Client appli
bleBegin();

void loop() {
// If the flag "doConnect" is true then we have s
// BLE Server with which we wish to connect. Now
// connected we set the connected flag to be true
if (doConnect == true) {
if (connectToServer()) {
Serial.println("We are now connected to the E

} else {

Serial.println("We have failed to connect to
¥
doConnect = false;

}
/****************Data tpansmitting Section*********
/****************************************/
if (connected) { //Send data when connected to Lt
pTXRemoteCharacteristic->writeValue("I am the h
pTXRemoteCharacteristic->writeValue("Hello clie
}
if(!connected){ //Rescan when not connected to t
BLEDevice::getScan()->start(5,false); // this

}

/****************************************/

/****************************************/

delay(1000);
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void bleBegin()
{

BLEDevice::init("");

// Retrieve a Scanner and set the callback we wan
// have detected a new device. Specify that we w
// scan to run for 5 seconds.

BLEScan* pBLEScan = BLEDevice::getScan();
pBLEScan->setAdvertisedDeviceCallbacks(new MyAdve
pBLEScan->setInterval(1349);//Set the scan interv
pBLEScan->setWindow(449);//Active scan time
pBLEScan->setActiveScan(true);

pBLEScan->start(5, false);//Scan time, in seconds

}

//Bluetooth connection processing

bool connectToServer() {
Serial.print("Forming a connection to ");
Serial.println(myDevice->getAddress().toString(

BLEClient* pClient = BLEDevice::createClient(
Serial.println(" - Created client");

pClient->setClientCallbacks(new MyClientCallbac

// Connect to the remove BLE Server.
pClient->connect(myDevice); // if you pass BLE
Serial.println(" - Connected to server");
pClient->setMTU(517); //set client to request n

// Obtain a reference to the service we are aft
BLERemoteService* pRemoteService = pClient->get
if (pRemoteService == nullptr) {
Serial.print("Failed to find our service UUIL
Serial.println(serviceUUID.toString().c_str()
pClient->disconnect();
return false;

}

Serial.println(" - Found our service");

// Obtain a reference to the characteristic in
pTXRemoteCharacteristic = pRemoteService->getCh
if (pTXRemoteCharacteristic == nullptr) {
Serial.print("Failed to find our characterist
Serial.println(charTXUUID.toString().c_str())
pClient->disconnect();
return false;
¥
pRXRemoteCharacteristic = pRemoteService->getCh
if (pRXRemoteCharacteristic == nullptr) {
Serial.print("Failed to find our characterist
Serial.println(charRXUUID.toString().c_str())
pClient->disconnect();
return false;

}

Serial.println(" - Found our characteristic");

if(pRXRemoteCharacteristic->canNotify())
pRXRemoteCharacteristic->registerForNotify(nc

connected = true;
return true;

}
| | [

Slave code
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/*
Based on Neil Kolban example for IDF: https://g
Ported to Arduino ESP32 by Evandro Copercini
updates by chegewara

*/

#include <BLEDevice.h>
#include <BLEUtils.h>
#include <BLEServer.h>
#include <BLE2962.h>

// See the following for generating UUIDs:
// https://www.uuidgenerator.net/

#define SERVICE_UUID "4fafc201-1fb5-459e-8fc
#define CHARACTERISTIC_UUID_RX "beb5483e-36el-4688-
#define CHARACTERISTIC_UUID_TX "beb5483f-36el-4688-
uint8_t txValue = 0;

bool deviceConnected = false;

BLECharacteristic *pTxCharacteristic;

//Bluetooth connect/disconnect processing. Triggere
class MyServerCallbacks: public BLEServerCallbacks
void onConnect(BLEServer* pServer) { //This
Serial.println("Bluetooth connected");
deviceConnected = true;

1

void onDisconnect(BLEServer* pServer) { //This
Serial.println("Bluetooth disconnected");
deviceConnected = false;
delay(500); // give the bluetooth stack the
BLEDevice: :startAdvertising(); // restart &

i;***************Data receiving Section************
/****************************************/
//Bluetooth receive data processing. Triggered autc
class MyCallbacks: public BLECharacteristicCallback
void onWrite(BLECharacteristic *pCharacteristic
std::string rxValue = pCharacteristic->getVal

//if(rxValue == "ON"){Serial.println("Turn on

if (rxValue.length() > @) {
Serial.println("*****kkkkxn)
Serial.print("Received Value: ");
for (int i = ©; i < rxValue.length(); i++)
Serial.print(rxValue[i]); //Print

Serial.println();
Serial.pr‘intln("*********")i

}s

/****************************************/

/****************************************/

void setup() {
Serial.begin(115200);
Serial.println("Starting BLE work!");
bleBegin();

/****************Data Sending Section*************/
/****************************************/
void loop() {
if(deviceConnected){ //Send data when a device i
pTxCharacteristic->setValue("I am a slave");
pTxCharacteristic->notify();
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pTxCharacteristic->setValue("Hello Sever");
pTxCharacteristic->notify();
¥

/****************************************/

/****************************************/

delay(1000);

void bleBegin()
{
BLEDevice::init(/*BLE name*/"Long name works now"
BLEServer *pServer = BLEDevice::createServer();
pServer->setCallbacks(new MyServerCallbacks());
BLEService *pService = pServer->createService(SER
BLECharacteristic *pRxCharacteristic = pService->
CHARACTERI
BLECharact
)
pRxCharacteristic->setCallbacks(new MyCallbacks()

pTxCharacteristic = pService->createCharacteristic
CHARACTERI
BLECharact
)
pTxCharacteristic->addDescriptor(new BLE2962());

pService->start();

// BLEAdvertising *pAdvertising = pServer->getAdv
BLEAdvertising *pAdvertising = BLEDevice::getAdve
pAdvertising->addServiceUUID(SERVICE_UUID);
pAdvertising->setScanResponse(true);
pAdvertising->setMinPreferred(0x06); // function
pAdvertising->setMinPreferred(0x12);
BLEDevice::startAdvertising();

J | i

7.3 WIFI control LED

ESP32C3 has WIFI function, the following example uses
ESP32C3 to create a wifi server, use the client to connect to
the server, and control the on and off of LED

Steps

1. Connect to WIFI "Beetle ESP32 C3", WIFI password has
been set: 12345678

2. Visit the website http://192.168.4.1/ON to turn on the
light Visit http://192.168.4.1/OFF to turn off the light

3. After the visit, click the up and down to conveniently
control the on and off of the light without entering the
URL.

Code

/*

Steps:

1. Connect to WIFI "Beetle ESP32 C3", WIFI passworc
2. Visit the website http://192.168.4.1/0N to turn
3. After the visit, click the up and down to conven
*/

#include <WiFi.h>
#include <WiFiClient.h>
#include <WiFiAP.h>

Downloaded from Arrow.com.
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#define myLED 10 //Set pin 10 as LED pin

// Set WIFI name and password

const char *ssid = "Beetle ESP32 C3";//WIFI name
const char *password = "12345678";//password

WiFiServer server(80);//The default web service por

void setup() {
pinMode(myLED, OUTPUT);

Serial.begin(115200);
Serial.println();
Serial.println("Configuring access point...");

//If you want to open the network without a passuw
WiFi.softAP(ssid, password);

IPAddress myIP = WiFi.softAPIP();
Serial.print("AP IP address: ");
Serial.println(myIP);

server.begin();

Serial.println("Server started");

void loop() {
WiFiClient client = server.available(); // dete

if (client) { // chec
Serial.println("New Client.");
String currentLine = ""; // cresa
while (client.connected()) { // keeg
if (client.available()) { // chec
char ¢ = client.read(); // reac
//Serial.write(c); // pr
if (c == "\n") { // if n

//end with a newline reminder

if (currentLine.length() == 0) {
client.println("HTTP/1.1 200 OK");
client.println("Content-type:text/html"
client.println();
//connect characters with here
client.print("Click <a href=\"/ON\">her
client.print("Click <a href=\"/OFF\">he

// HTTP response is blank
client.println();
// Break out of the loop

break;
} else { // Clear variable cached date
currentLine = "";
}
} else if (c != '\r") { // If you get char
currentlLine += c; // The obtained ch

// Check to see if /ON or /OFF

if (currentLine.endsWith("/ON")) {
digitalWrite(myLED, HIGH);

¥

if (currentLine.endsWith("/OFF")) {
digitalWrite(myLED, LOW);

}

// Disconnect
client.stop();
Serial.println("Client Disconnected.");

Downloaded from AFfOW.CoOm. | | 9|
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ROBOT

DRIVE THE FUTURE

Q search

Controller
DFR0182 Wirless GamePad V2.0

DFR0100 DFRduino Beginner Kit For
Arduino V3

DFR0267 Bluno

DFRO0282 Beetle

DFR0283 Dreamer Maple V1.0
DFR0296 Bluno Nano

DFR0302 MiniQ 2WD Plus
DFR0304 BLE Wireless Gamepad V2
DFR0305 RoMeo BLE

DFR0351 Romeo BLE mini V2.0
DFR0306 Bluno Mega 1280

DFR0321 Wido-WIFI IoT Node

Downloaded from AFfOW.com.
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1. Introduction

2. Features
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4. Schematic diagram of
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5. The first time to use

6. Basic Tutorial (Introduce
the difference between

Arduino)
7. Advanced Tutorial

8. Application example

expansion
FAQ

More Documents

Result

Use the mobile phone to connect to this wifi, access
192.168.4.1 through the browser, as shown in the figure, the
ip address is 192.168.4.1, and the service is enabled.

@ comi7 - o x

| Send

ACCEpPL-LalgUaye s ZI-CN, ZI; §=U- 7, €[-U5; §=U- 0, €, J=U+ =

Client Disconnected.

[New Client.

GET /favicon.ico HTTP/1.1

Host: 192.168.4.1

Connection: keep-alive

[User-Agent: Mozilla/5.0 (Linux; Android 10; HarmonyOS; YAL-ALOO; HMSCore 6.1.0.314; GMSC
DNT: 1

Accept: image/webp, image/apng, image/svg+xml, image/*, */*;q=0.8
[Referer: http://192.168.4.1/0N

Accept-Encoding: gzip, deflate

Accept-Language: zh-CN, zh;q=0.9,en-US;g=0.8,en;g=0.7

Client Disconnected.

M sutosers 11 [Jshor timestanp Nerline | 115200 baud v | Clear output

Use a browser to access the ip address and get it as shown
below

Click here to turn ON the LED.
Click here to turn OFF the LED.

Try clicking the links separately to control the LEDs

Member function

e WiFiServer server()
Description: Set the server port

o softAP(ssid,password)

Description: Configure WiFi as AP mode, and set the

FORUM BLOG

o ssid: wifi name in AP mode

o password: wifi password in ap mode

e server.available()
Description: Check whether the service port is
connected (whether WIFI is connected)

e client.connected()
Description: Check connection status
Return value: true/false

e client.available()
Description: Detect whether there is data input
connected to WIFI

e client.read()
Description: Read WIFI received data

e currentLine.endsWith()
Description: Check whether the bracket content is
obtained

e client.stop()
Description: Disconnect

8. Application example expansion
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DFRO0323 Bluno Mega 2560

DFR0329 Bluno M3

DFR0339 Bluno Beetle

DFR0343 UHex Low-power Controller

DFR0355 SIM808 with Leonardo
mainboard

DFR0392 DFRduino MO Mainboard
Arduino Compatible

DFR0398 Romeo BLE Quad Robot
Controller

DFR0416 Bluno M0 Mainboard
DFRO0575 Beetle ESP32
DFRO0133 X-Board

DFR0162 X-Board V2

DFR0428 3.5 inches TET Touchscreen
for Raspberry Pi

DFR0494 Raspberry Pi UPS HAT

DFR0514 DFR0603 IIC 16X2 RGB
LCD KeyPad HAT V1.0

DFR0524 5.5 HDMI OLED-Display
with Capacitive Touchscreen V2.0

DFR0550 5" TFT-Display with
Touchscreen V1.0

DFRO0591 raspberry pi e-ink display
module V1.0

DFR0592 DC Motor Driver HAT

DFR0604 I O Expansion HAT for Pi
zero V1.0

DFRO0566 10 Expansion HAT for
Raspberry Pi

DFR0528 UPS HAT for Raspberry Pi
Zero

DFR0331 Romeo for Edison Controller

DFR0453 DFRobot CurieNano - A mini
Genuino Arduino 101 Board

TELO0110 CurieCore intel® Curie
Neuron Module

DFR0478 FireBeetle ESP32 IOT
Microcontroller(V3.0) Supports Wi-Fi
& Bluetooth

DFR0483 FireBeetle Covers-Gravity |
O Expansion Shield

FireBeetle Covers-24x8 LED Matrix

TELO121 FireBeetle Covers-LoRa

Radia 42 L]
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8.1 OLED display measured temperature
and humidity

Getting the temperature and humidity displayed on the OLED
screen is a very intuitive and interesting project. Below you
will learn the basic OLED display and use the 12C interface to
obtain the temperature and humidity sensor data. You need
to prepare

e 0.96"128x64 1IC/SPI OLED monochrome display x1
e Jumper Wires

e FermionSHT30 temperature and humidity sensor x1 (or
other SHT temperature and humidity sensor using the
same SHT3x code base)

1. You need to install the SHT3x library first. For how to
install the library, click here.

2. Wiring diagram

L-INIW-€2-2€dS3
HSSIHISS &

Connect the wires according to the picture above and copy
the code below, you will see the temperature and humidity
conditions around you.

#include <Arduino.h>

#include <U8g2lib.h> //Import font library
//#include <SPI.h>

#include <Wire.h>

#include <DFRobot_SHT3x.h>

/*

---Display hardware I2C interface---

U8G2_RO does not rotate, landscape, drawing directi
U8G2_R1 is rotated 90 degrees clockwise, and the dr
U8G2_R2 is rotated 180 degrees clockwise, and the ¢
U8G2_R3 is rotated 270 degrees clockwise, and the ¢
U8G2_MIRROR displays mirrored content normally (use
U8x8_PIN_NONE means the pin is empty and the reset
---Display hardware SPI interface---

Connect cs by pin (pin can be selected by yourself)
Connect dc by pin (pin can be selected by yourself)
*/

U8G2_SSD1306_128X64 NONAME_F_HW_I2C u8g2(/* rotatic

//When ADR is connected to VDD, ©x45 can be selecte
//The default is 0x45, RST (reset pin) does not nee
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TELO0122 FireBeetle Covers-LoRa
Radio 915MHz

TELO0125 FireBeetle Covers LoRa
Radio 868MHz

DFR0489 FireBeetle ESP8266 10T
Microcontroller

DFR0492 FireBeetle Board-328P with
BLEA4.1

DFR0498 FireBeetle Covers-
Camera&Audio Media Board

DFRO0507 FireBeetle Covers-
OLED12864 Display

DFRO0508 FireBeetle Covers-DC Motor

& Stepper Driver

DFRO511 FireBeetle Covers-ePaper
Black&White Display Module

DFRO0531 FireBeetle Covers-ePaper
Black&White&Red Display Module

DFRO0536 Micro bit Gamepad
Expansion Board

DFR0548 Micro bit Driver Expansion
Board

ROB0148 micro: Maqueen for micro:bit

ROBO0150 Micro bit Circular RGB LED
Expansion Board

MBT0005 micro [0-BOX

SEN0159 CO2 Sensor

DFR0049 DFRobot Gas Sensor
TOY0058 Barometric Pressure Sensor

SEN0220 Infrared CO2 Sensor 0-
50000ppm

SEN0219 Gravity Infrared CO2 Sensor
For Arduino

SEN0226 Gravity [2C BMP280
Barometer Sensor

SEN0231 Gravity HCHO Sensor

SEN0251 Gravity BMP280 Barometric
Pressure Sensors

SENO0132 Carbon Monoxide Gas
Sensor MQ7

SEN0032 Triple Axis Accelerometer
Breakout - ADX1.345

DFRO0143 Triple Axis Accelerometer
MMA7361

Triple Axis Accelerometer FXLN83XX

Series
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DFRobot_SHT3x sht3x(&Wire,/*address=*/0x45,/*RST=*/

//To use SPI, you need to comment the above code an
//DFRobot_SHT3x sht3x;

void setup() {
Serial.begin(115200);
u8g2.begin();
u8g2.setFontPosTop();//When using drawStr to disp
//Initialize the sensor
while (sht3x.begin() != 0) {
Serial.println("Failed to Initialize the ch
delay(1000);
}
Serial.print("Chip serial number");
Serial.println(sht3x.readSerialNumber());
if(!sht3x.softReset()){
Serial.println("Failed to Initialize the ¢

}

void loop() {
//Clean the screen
u8g2.clearBuffer();
//Use temperature and humidity read assignments f
float  temp = sht3x.getTemperatureC();
float humi = sht3x.getHumidityRH();
//Display temperature
u8g2.setFont(u8g2_font_osbl8_tf); // Choose fc
u8g2.drawStr(5,10,"Temp");//Write the character z
u8g2.setFont(u8g2_font_t0_18b_tr);
u8g2.setCursor(75, 15);//Display starts from this
u8g2.print(temp);
//Display humidity
u8g2.setFont(u8g2_font_osbl8_tf);
u8g2.drawStr (5,40, "Humi");
u8g2.setFont(u8g2_font_t@_18b_tr);
u8g2.setCursor(75, 45);
udg2.print(humi);
u8g2.sendBuffer();
delay(1000);

}

| 2 — i3
Result

Member function

e u8g2.drawStr(x,y,"Temp")
Description: Specify the screen position to display
custom content
Parameter:

o X, Y: coordinates to start writing (the display font is
displayed from the lower left corner to the upper
right corner)

o "Temp": English and numbers can be filled

e u8g2.setCursor(x,y) and u8g2.print()
Description: Used together, the former is to display the
starting position, and the latter has the same function as
Arduino's print
Parameter:

o X, Y: coordinates to start writing (the display font is
displayed from the lower left corner to the upper
right corner)
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SEN0072 CMPS09 - Tilt Compensated
Magnetic Compass

SENO0073 9 Degrees of Freedom -
Razor IMU

DFRO0188 Flymaple V1.1

SEN0224 Gravity 12C Triple Axis
Accelerometer - LIS2DH

SEN0140 10 DOF Mems IMU Sensor
V2.0

SEN0250 Gravity BMI160 6-Axis
Inertial Motion Sensor

SEN0253 Gravity BNOO055 + BMP280
intelligent I0DOF AHRS

SEN0001 URM37 V5.0 Ultrasonic
Sensor

SEN0002 URMO04 V2.0

SEN0004 SRF01 Ultrasonic sensor
SENO0005 SRF02 Ultrasonic sensor
SEN0006 SRF05 Ultrasonic sensor
SEN0007 SRFO08 Ultrasonic Sensor
SENO0008 SRF10 Ultrasonic sensor
SEN0149 URMO06-RS485 Ultrasonic
SEN0150 URMO06-UART Ultrasonic
SENO0151 URMO6-PULSE Ultrasonic

SENO0152 URMO06-ANALOG
Ultrasonic

SENO0153 URMO7-UART Ultrasonic
Sensor

SEN0246 URMO08-RS485 Waterproof
Sonar Range Finder

SEN0304 URMO09 Ultrasonic Sensor
(Gravity-12C) (V1.0)

SEN0304 URMO9 Ultrasonic Sensor
(Gravity-12C) (V1.0)

SEN0300 Water-proof Ultrasonic
Sensor ULS

SEN0301 Water-proof Ultrasonic
Sensor ULA

SEN0307 URMO9 Ultrasonic Sensor
Gravity Analog

SEN0311 A02YYUW Waterproof
Ultrasonic Sensor

SEN0312 ME007YS Waterproof
Ultrasonic Sensor
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8.2 Use WIFI to obtain temperature and
humidity

This example is based on Example 8.3 to further learn the
information transfer of Wifi under the LAN. You can learn
how to access the IP address under the LAN to obtain the
temperature and humidity sensor status of the SHT30 in
another place. You need to prepare

e FermionSHT30 temperature and humidity sensor x1 (or
other SHT temperature and humidity sensors using the
same SHT3x code base)

e Jumper Wires You will also need to follow the steps in
Example 9.1 to install the sensor library and connect it
with the ESP32.

Wiring diagram

[5)
=4
S}

w
<
W

2
&Lt

LINIW-EJ-2€dS3

JISSIHISI@®

?
0
®
®
a4
e
6
®
.
®
;
®

VCCGNDSCL SDA INT RST

Steps

1. Connect to WIFI "Beetle ESP32 C3", WIFI password has
been set: 12345678

2. Visit the website http://192.168.4.1/GET to get the
temperature and humidity information in the LAN

3. In the temperature and humidity display page, you can
update the sensor data by refreshing

Code

/*
In this example, SHT30 is connected to ESPC3 to obt
*/

#include <WiFi.h>
#include <WiFiClient.h>
#include <WiFiAP.h>
#include <DFRobot_SHT3x.h>

//When ADR is connected to VDD, 0x45 can be selecte
//The default is Ox45, RST (reset pin) does not nee
DFRobot_SHT3x sht3x(&Wire,/*address=*/0x45,/*RST=*/

//To use SPI, you need to comment the above code an
//DFRobot_SHT3x sht3x;

// Set WIFI name and password

const char *ssid = "Beetle ESP32 C3";//WIFI name
const char *password = "12345678";//password
WiFiServer server(80);//The default web service por

// Display the last sensor status feedback status

void setup() {


https://wiki.dfrobot.com/Triple_Axis_Accelerometer_FXLN83XX_Series
https://wiki.dfrobot.com/CMPS09_-_Tilt_Compensated_Magnetic_Compass__SKU_SEN0072_
https://wiki.dfrobot.com/9_Degrees_of_Freedom_-_Razor_IMU__SKU_SEN0073_
https://wiki.dfrobot.com/Flymaple_V1.1_SKU_DFR0188_
https://wiki.dfrobot.com/Gravity__I2C_Triple_Axis_Accelerometer_-_LIS2DH_SKU_SEN0224
https://wiki.dfrobot.com/10_DOF_Mems_IMU_Sensor_V2.0_SKU__SEN0140
https://wiki.dfrobot.com/Gravity__BMI160_6-Axis_Inertial_Motion_Sensor_SKU__SEN0250
https://wiki.dfrobot.com/Gravity_BNO055_+_BMP280%20intelligent_10DOF_AHRS_SKU_SEN0253
https://wiki.dfrobot.com/URM37_V5.0_Ultrasonic_Sensor_SKU_SEN0001_
https://wiki.dfrobot.com/URM04_V2.0__SKU_SEN0002_
https://wiki.dfrobot.com/SRF01_Ultrasonic_sensor__SKU_SEN0004_
https://wiki.dfrobot.com/SRF02_Ultrasonic_sensor__SKU_SEN0005_
https://wiki.dfrobot.com/SRF05_Ultrasonic_sensor__SKU_SEN0006_
https://wiki.dfrobot.com/SRF08_Ultrasonic_Sensor__SKU_SEN0007_
https://wiki.dfrobot.com/SRF10_Ultrasonic_sensor__SKU_SEN0008_
https://wiki.dfrobot.com/URM06-RS485_Ultrasonic_SKU_SEN0149
https://wiki.dfrobot.com/URM06-UART_Ultrasonic_SKU_SEN0150
https://wiki.dfrobot.com/URM06-PULSE_Ultrasonic_SKU_SEN0151
https://wiki.dfrobot.com/URM06-ANALOG_Ultrasonic_SKU_SEN0152
https://wiki.dfrobot.com/URM07-UART_Ultrasonic_Sensor_SKU__SEN0153
https://wiki.dfrobot.com/URM08-RS485_Waterproof_Sonar_Range_Finder_SKU_SEN0246
https://wiki.dfrobot.com/URM09_Ultrasonic_Sensor_(Gravity-I2C)_(V1.0)_SKU_SEN0304
https://wiki.dfrobot.com/URM09_Ultrasonic_Sensor_(Gravity-I2C)_(V1.0)_SKU_SEN0304
https://wiki.dfrobot.com/_SKU_SEN0300_Water-proof_Ultrasonic_Sensor__ULS_
https://wiki.dfrobot.com/_SKU_SEN0301_Water-proof_Ultrasonic_Sensor__ULA_
https://wiki.dfrobot.com/URM09_Ultrasonic_Sensor_(Gravity_Analog)_SKU_SEN0307
https://wiki.dfrobot.com/_A02YYUW_Waterproof_Ultrasonic_Sensor_SKU_SEN0311
https://wiki.dfrobot.com/_ME007YS_Waterproof_Ultrasonic_Sensor_SKU_SEN0312
https://wiki.dfrobot.com/_A01NYUB_Waterproof_Ultrasonic_Sensor_SKU_SEN0313
https://www.dfrobot.com/product-2012.html
https://www.dfrobot.com/product-356.html
http://192.168.4.1/GET
http://www.arrow.com

SEN0313 AOINYUB Waterproof
Ultrasonic Sensor

DFR0066 SHT 1x Humidity and
Temperature Sensor

DFR0067 DHT11 Temperature and
Humidity Sensor

SENO0137 DHT22 Temperature and
humidity module

DFR0023 DFRobot LM35 Linear
Temperature Sensor

DFR0024 Gravity DS18B20
Temperature Sensor Arduino
Compatible V2

DFR0024 Gravity DS18B20
Temperature Sensor Arduino
Compatible V2

SENO1 14 Moisture Sensor

TOY0045 TMP100 Temperature
Sensor

TOY0054 SI7021 Temperature and
humidity sensor

SEN0206 IR Thermometer Sensor
MLX90614

SEN0227 SHT20 [2C Temperature &
Humidity Sensor Waterproof Probe

SEN0236 Gravity [2C BME280
Environmental Sensor Temperature,
Humidity, Barometer

SEN0248 Gravity 12C BME680
Environmental Sensor VOC,
Temperature, Humidity, Barometer

DFRO0558 Gravity Digital High
Temperature Sensor K-type

SEN0308 Waterproof Capacitive Soil
Moisture Sensor

SEN0019 Adjustable Infrared Sensor
Switch

SEN0042 DFRobot Infrared sensor
breakout

SEN0143 SHARP GP2Y0A41SKOF
IR ranger sensor 4-30cm

SENO0013 Sharp GP2Y0A02YK IR
ranger sensor 150cm

SENO0014 Sharp GP2Y0A21 Distance
Sensor 10-80cm

SEN0085 Sharp GP2Y0A710K
Distance Sensor 100-550cm

DFR0094 Digital IR Receiver Module

N\ D £ 1) A ». -
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/1

Se
Se

pinMode(myLED, OUTPUT);

rial.begin(115200);
rial.println();

Serial.println("Configuring access point...");

//If you want to open the network without a passu

Wi

Fi.softAP(ssid, password);

IPAddress myIP = WiFi.softAPIP();

Se
Se
se

Se

//
wh

rial.print("AP IP address: ");
rial.println(myIP);
rver.begin();

rial.println("Server started");
Initialize the sensor
ile (sht3x.begin() != 0) {

Serial.println("Failed to Initialize the ch

delay(1000);
¥

Serial.print("Chip serial number");

Serial.println(sht3x.readSerialNumber());

if(!sht3x.softReset()){

Serial.println("Failed to Initialize the ¢

¥
}
void loop() {
WiFiClient client = server.available(); // detect
if (client) { // chec
Serial.println("New Client.");
String currentLine = ""; // cree
while (client.connected()) { // keep
if (client.available()) { // chec
char ¢ = client.read(); // read
//Serial.write(c); // pr
if (c == "\n") { // if n
//Clear the cached content
if (currentLine.length() == 0) {
client.print(" ");
break;
} else { // Clear variable cached datz
currentLine = "";
}
} else if (c != '\r") { // If you get char
currentLine += c; // The obtained ch
¥
// Check if /GET is at the end
if (currentLine.endsWith("/GET")) {
//Read temperature and humidity
float temp = sht3x.getTemperatureC()
float humi = sht3x.getHumidityRH();
//Print on web page
client.print("temp (C): "); client.pri
client.print("humi (%RH): "); client.p
¥
}
¥
// Disconnect
client.stop();
Serial.println("Client Disconnected.");
}
¥
< J 2l
Result


https://wiki.dfrobot.com/_A01NYUB_Waterproof_Ultrasonic_Sensor_SKU_SEN0313
https://wiki.dfrobot.com/SHT1x_Humidity_and_Temperature_Sensor__SKU__DFR0066_
https://wiki.dfrobot.com/DHT11_Temperature_and_Humidity_Sensor__SKU__DFR0067_
https://wiki.dfrobot.com/DHT22_Temperature_and_humidity_module_SKU_SEN0137
https://wiki.dfrobot.com/DFRobot_LM35_Linear_Temperature_Sensor__SKU_DFR0023_
https://wiki.dfrobot.com/Gravity__DS18B20_Temperature_Sensor__Arduino_Compatible__V2_SKU__DFR0024
https://wiki.dfrobot.com/Gravity__DS18B20_Temperature_Sensor__Arduino_Compatible__V2_SKU__DFR0024
https://wiki.dfrobot.com/Moisture_Sensor__SKU_SEN0114_
https://wiki.dfrobot.com/TMP100_Temperature_Sensor__SKU_TOY0045_
https://wiki.dfrobot.com/SI7021_Temperature_and_humidity_sensor_SKU_TOY0054
https://wiki.dfrobot.com/IR_Thermometer_Sensor_MLX90614_SKU__SEN0206
https://wiki.dfrobot.com/SHT20_I2C_Temperature_&_Humidity_Sensor__Waterproof_Probe__SKU__SEN0227
https://wiki.dfrobot.com/Gravity__I2C_BME280_Environmental_Sensor__Temperature,_Humidity,_Barometer__SKU__SEN0236
https://wiki.dfrobot.com/Gravity__I2C_BME680_Environmental_Sensor__VOC,_Temperature,_Humidity,_Barometer__SKU__SEN0248
https://wiki.dfrobot.com/Gravity__Digital_High_Temperature_Sensor__K-type__SKU_DFR0558
https://wiki.dfrobot.com/_Waterproof_Capacitive_Soil_Moisture_Sensor_SKU_SEN0308
https://wiki.dfrobot.com/Adjustable_Infrared_Sensor_Switch__SKU_SEN0019_
https://wiki.dfrobot.com/DFRobot_Infrared_sensor_breakout__SKU_SEN0042_
https://wiki.dfrobot.com/SHARP_GP2Y0A41SK0F_IR_ranger_sensor__4-30cm__SKU_SEN0143
https://wiki.dfrobot.com/Sharp_GP2Y0A02YK_IR_ranger_sensor__150cm___SKU_SEN0013_
https://wiki.dfrobot.com/Sharp_GP2Y0A21_Distance_Sensor__10-80cm___SKU_SEN0014_
https://wiki.dfrobot.com/Sharp_GP2Y0A710K_Distance_Sensor__100-550cm__SKU__SEN0085
https://wiki.dfrobot.com/Digital_IR_Receiver_Module__SKU_DFR0094_
https://wiki.dfrobot.com/DIGITAL_IR_Transmitter_Module__SKU_DFR0095_
http://www.arrow.com

Module
SENO0018 Digital Infrared motion sensor
DFRO0107 IR Kit

SEN0264 TS01 IR Thermal Sensor (4-
20mA)

SENO0169 Analog pH Meter Pro

DFR0300-H Gravity: Analog Electrical
Conductivity Sensor(K=10)

DFR0300 Gravity Analog Electrical
Conductivity Sensor Meter V2 K=1

SENO0165 Analog ORP Meter

SEN0161-V2 Gravity Analog pH
Sensor Meter Kit V2

SENO0161 PH meter

SENO0237 Gravity Analog Dissolved
Oxygen Sensor

SEN0204 Non-contact Liquid Level
Sensor XKC-Y25-T12V

SEN0205 Liquid Level Sensor-FS-IR02

SEN0244 Gravity Analog TDS Sensor
Meter For Arduino

SEN0249 Gravity Analog Spear Tip pH
Sensor Meter Kit For Soil And Food
Applications

SENO0121 Steam Sensor

SEN0097 Light Sensor

DFR0026 DFRobot Ambient Light
Sensor

TOY0044 UV Sensor
SENO0172 LX1972 ambient light sensor

SEN0043 TEMT6000 ambient light
sensor

SENO0175 UV Sensor v1.0-ML8511

SEN0228 Gravity [2C VEML7700
Ambient Light Sensor

SEN0101 TCS3200 Color Sensor
DFR0022 DFRobot Grayscale Sensor

SENO0017 Line Tracking Sensor for
Arduino V4

SENO0147 Smart Grayscale sensor

SEN0212 TCS34725 I12C Color Sensor
For Arduino

SEN0245 Gravity VL53L0X ToF Laser

R . ~ 108 -
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You can access the website through a mobile phone,
computer, etc. to obtain the following results (temperature
and humidity under the LAN).

@ Sl = 5t @ N © B30t @) 3:58

® 192.168.4.1/GET @

temp (C): 25.13
humi (%RH): 54.14

Member function

o WiFi.softAP(ssid, password)
Description: Similar to opening the hotspot with the set
WIFI account password
Parameter:

o ssid: WIFI name

o password: WIFI password

e WiFi.softAPIP()
Description: WIFI IP address

8.3 Get network time with WIFI

This example demonstrates getting the time from a network
time server and using the RTC clock that comes with the
ESP32 to keep the time updated. This example comes from
CSDN blogger "Naisu Xu", the original link:


https://wiki.dfrobot.com/DIGITAL_IR_Transmitter_Module__SKU_DFR0095_
https://wiki.dfrobot.com/Digital_Infrared_motion_sensor__SKU_SEN0018_
https://wiki.dfrobot.com/IR_Kit_SKU_DFR0107_
https://wiki.dfrobot.com/TS01_IR_Thermal_Sensor_(4-20mA)_SKU_SEN0264
https://wiki.dfrobot.com/Analog_pH_Meter_Pro_SKU_SEN0169
https://wiki.dfrobot.com/Gravity_Analog_Electrical_Conductivity_Sensor_Meter_K=10_SKU_DFR0300-H
https://wiki.dfrobot.com/Gravity__Analog_Electrical_Conductivity_Sensor___Meter_V2__K=1__SKU_DFR0300
https://wiki.dfrobot.com/Analog_ORP_Meter_SKU_SEN0165_
https://wiki.dfrobot.com/Gravity__Analog_pH_Sensor_Meter_Kit_V2_SKU_SEN0161-V2
https://wiki.dfrobot.com/PH_meter_SKU__SEN0161_
https://wiki.dfrobot.com/Gravity__Analog_Dissolved_Oxygen_Sensor_SKU_SEN0237
https://wiki.dfrobot.com/Non-contact_Liquid_Level_Sensor_XKC-Y25-T12V_SKU__SEN0204
https://wiki.dfrobot.com/Liquid_Level_Sensor-FS-IR02_SKU__SEN0205
https://wiki.dfrobot.com/Gravity__Analog_TDS_Sensor___Meter_For_Arduino_SKU__SEN0244
https://wiki.dfrobot.com/Gravity__Analog_Spear_Tip_pH_Sensor___Meter_Kit__For_Soil_And_Food_Applications__SKU__SEN0249
https://wiki.dfrobot.com/Steam_Sensor__SKU_SEN0121_
https://wiki.dfrobot.com/Light_Sensor__SKU_SEN0097_
https://wiki.dfrobot.com/DFRobot_Ambient_Light_Sensor_SKU_DFR0026
https://wiki.dfrobot.com/UV_Sensor__SKU_TOY0044_
https://wiki.dfrobot.com/LX1972_ambient_light_sensor_SKU_SEN0172
https://wiki.dfrobot.com/TEMT6000_ambient_light_sensor_SKU_SEN0043
https://wiki.dfrobot.com/UV_Sensor_v1.0-ML8511_SKU_SEN0175
https://wiki.dfrobot.com/Gravity__I2C_VEML7700_Ambient_Light_Sensor_SKU__SEN0228
https://wiki.dfrobot.com/TCS3200_Color_Sensor__SKU_SEN0101_
https://wiki.dfrobot.com/DFRobot_Grayscale_Sensor__SKU_DFR0022_
https://wiki.dfrobot.com/Line_Tracking_Sensor_for_Arduino_V4_SKU_SEN0017
https://wiki.dfrobot.com/Smart_Grayscale_sensor_SKU_SEN0147
https://wiki.dfrobot.com/TCS34725_I2C_Color_Sensor_For_Arduino_SKU__SEN0212
https://wiki.dfrobot.com/Gravity__VL53L0X_ToF_Laser_Range_Finder_SKU_SEN0245
http://www.arrow.com

SEN0259 TF Mini LiDAR ToF Laser
Range Sensor

SEN0214 20A Current Sensor
SEN0262 Gravity Analog Current to
Voltage Converter for 4~20mA

Application

SEN0291 Gravity: I2C Digital
Wattmeter

DFR0027 DFRobot Digital Vibration
Sensor V2

DFR0028 DFRobot Tilt Sensor
DFR0029 DFRobot Digital Push Button

DFR0030 DFRobot Capacitive Touch
Sensor

DFRO0032 Digital Buzzer Module
DFRO0033 Digital magnetic sensor
DFR0034 Analog Sound Sensor

SEN0038 Wheel Encoders for
DFRobot 3PA and 4WD Rovers

DFRO0051 Analog Voltage Divider

DFR0052 Analog Piezo Disk Vibration
Sensor

DFR0076 Flame sensor

DFR0053 Analog Slide Position Sensor

DFR0054 Analog Rotation Sensor V1
DFR0058 Analog Rotation Sensor V2
DFRO0061 Joystick Module For Arduino
DFR0075 ADKeyboard Module
DFRO0332 Fan Module

SENO0177 PM2.5 laser dust sensor
SEN0160 Weight Sensor Module

SENO0170 Wind Speed Sensor Voltage
Type 0-5V

TOY0048 High Accuracy Dual Axis
Inclinometer Sensor Arduino Gadgeteer
Compatible

SENO0187 RGB and Gesture Sensor

SEN0186 Weather Station with
Anemometer Wind vane Rain bucket

SEN0192 MicroWave Sensor
SENO0185 Hall sensor

FIT0449 DFRobot Speaker v1.0
Downloaded from Arrow.com.

https://blog.csdn.net/Naisu_kun/article/details/115627629

#include <WiFi.h>

const char *ssid = "¥¥kxdkkxi, //WIFI name
const char *password = "¥¥¥¥**kxxu. //WIFI password
const char *ntpServer = "pool.ntp.org";

const long gmtOffset_sec = 8 * 3600;
const int daylightOffset_sec = 0;

void printLocalTime()

{

struct tm timeinfo;

if (!getLocalTime(&timeinfo))

{
Serial.println("Failed to obtain time");
return;

¥
Serial.println(&timeinfo, "%F %T %A"); // formz

void setup()

{

Serial.begin(115200);
Serial.println();

WiFi.begin(ssid, password);
while (WiFi.status() != WL_CONNECTED)
{
delay(500);
Serial.print(".");
}

Serial.println("WiFi connected!");

// Get and set the time from the network time s
// After the acquisition is successful, the chi
configTime(gmtOffset_sec, daylightOffset_sec, n
printLocalTime();

WiFi.disconnect(true);
WiFi.mode(WIFI_OFF);
Serial.println("WiFi disconnected!");

void loop()

{

}

<

delay(1000);
printLocalTime();

struct tm structure

struct tm {

int tm_sec; // seconds, value 0~59;

int tm_min; // minutes, value 0~59;

int tm_hour; // hour, value ©~23;

int tm_mday; // The day of the month, the value is

int tm_mon; // month, value ©~11;

int tm_year; // year, whose value is equal to the @
int tm_wday; // week, value 0~6, © is Sunday, 1 is

int tm_yday; // The date of the year, value 0~365,

int tm_isdst; // Daylight saving time identifier, w
s

1 I— [

struct tm structure formatted output


https://wiki.dfrobot.com/Gravity__VL53L0X_ToF_Laser_Range_Finder_SKU_SEN0245
https://wiki.dfrobot.com/TF_Mini_LiDAR_ToF__Laser_Range_Sensor_SKU__SEN0259
https://wiki.dfrobot.com/20A_Current_Sensor_SKU_SEN0214
https://wiki.dfrobot.com/Gravity__Analog_Current_to_Voltage_Converter_for_4~20mA_Application__SKU_SEN0262
https://wiki.dfrobot.com/Gravity_I2C_Digital_Wattmeter_SKU_SEN0291
https://wiki.dfrobot.com/DFRobot_Digital_Vibration_Sensor_V2_SKU_DFR0027
https://wiki.dfrobot.com/DFRobot_Tilt_Sensor__SKU_DFR0028_
https://wiki.dfrobot.com/DFRobot_Digital_Push_Button_SKU_DFR0029
https://wiki.dfrobot.com/DFRobot_Capacitive_Touch_Sensor_SKU_DFR0030
https://wiki.dfrobot.com/Digital_Buzzer_Module__SKU__DFR0032_
https://wiki.dfrobot.com/Digital_magnetic_sensor_SKU__DFR0033
https://wiki.dfrobot.com/Analog_Sound_Sensor_SKU__DFR0034
https://wiki.dfrobot.com/Wheel_Encoders_for_DFRobot_3PA_and_4WD_Rovers__SKU_SEN0038_
https://wiki.dfrobot.com/Analog_Voltage_Divider_SKU__DFR0051
https://wiki.dfrobot.com/Analog_Piezo_Disk_Vibration_Sensor__SKU_DFR0052_
https://wiki.dfrobot.com/Flame_sensor_SKU__DFR0076
https://wiki.dfrobot.com/Analog_Slide_Position_Sensor__SKU__DFR0053_
https://wiki.dfrobot.com/Analog_Rotation_Sensor_V1__SKU__DFR0054_
https://wiki.dfrobot.com/Analog_Rotation_Sensor_V2__SKU__DFR0058_
https://wiki.dfrobot.com/Joystick_Module_For_Arduino_SKU_DFR0061
https://wiki.dfrobot.com/ADKeyboard_Module__SKU__DFR0075_
https://wiki.dfrobot.com/Fan_Module_DFR0332
https://wiki.dfrobot.com/PM2.5_laser_dust_sensor_SKU_SEN0177
https://wiki.dfrobot.com/Weight_Sensor_Module_SKU_SEN0160
https://wiki.dfrobot.com/Wind_Speed_Sensor_Voltage_Type_0-5V__SKU_SEN0170
https://wiki.dfrobot.com/High_Accuracy_Dual_Axis_Inclinometer_Sensor__Arduino_Gadgeteer_Compatible___SKU_TOY0048_
https://wiki.dfrobot.com/SEN0187_RGB_and_Gesture_Sensor
https://wiki.dfrobot.com/Weather_Station_with_Anemometer_Wind_vane_Rain_bucket_SKU_SEN0186
https://wiki.dfrobot.com/MicroWave_Sensor_SKU__SEN0192
https://wiki.dfrobot.com/Hall_sensor_SKU_SEN0185
https://wiki.dfrobot.com/DFRobot_Speaker_v1.0_SKU__FIT0449
https://wiki.dfrobot.com/Heart_Rate_Sensor_SKU__SEN0203
https://blog.csdn.net/Naisu_kun/article/details/115627629
http://www.arrow.com

SEN0203 Heart Rate Sensor
DFR0423 Self-Locking Swicth

SENO0213 Heart Rate Monitor Sensor

SENO0221 Gravity Hall Angle Sensor

SEN0223 Conductivity Switch Sensor

SEN0230 Incremental Photoelectric
Rotary Encoder - 400P R

SEN0235 EC11 Rotary Encoder
Module

SEN0240 Analog EMG Sensor by
OYMotion

SEN0232 Gravity Analog Sound Level
Meter

SEN0233 Air Quality Monitor PM 2.5,
Formaldehyde, Temperature & Humidity

Sensor

DFRO515 FireBeetle Covers-OSD
Character Overlay Module

SEN0257 Gravity Water Pressure
Sensor

SEN0289 Gravity: Digital Shake Sensor
SEN0290 Gravity: Lightning Sensor
DFR0271 GMR Board

ROB0003 Pirate 4WD Mobile Platform
ROBO0005 Turtle 2WD Mobile Platform

ROB0025 NEW A4WD Mobile Robot
with encoder

ROB0050 4WD MiniQ Complete Kit
ROBO0111 4WD MiniQ Cherokey
ROB0036 6 DOF Robotic Arm Kit
FIT0045 DF05BB Tilt Pan Kit

ROB0102 Cherokey 4WD Mobile
Platform

ROBO0117 Basic Kit for Cherokey 4WD
ROB0022 4WD Mobile Platform
ROBO0118 Basic Kit for Turtle 2WD
ROB0080 Hexapod Robot Kit

ROBO0112 Devastator Tank Mobile
Platform

ROBO01 14 Devastator Tank Mobile
Platform

ROBO0124 HCR Mobile Platform with
Downloaded from Arrow.com.

Formatting
characters

%a
%A
%b
%B
%c
%C
%d

%D

%e

%F

%9

%G
%h
%H
%l
%]
%m
%M
%op
Yor
%R
%S

%t

%T

%u

%U

%V

%w

%W

%X

%X

%y

Output

Abbreviation for day of the week
Full name of the day of the week
Abbreviation for month
Full name of month
Standard date string
Last two digits of the year
Day of the month in decimal
Month/day/year

Day of the month in decimal in a two-
character field

Year-month-day

The last two digits of the year, using a
week-based year

Years, use week-based years
Abbreviated month name
24 hour clock
12 hour clock
Day of the year in decimal
Month in decimal
Minutes in decimal
Equivalent display of local AM or PM
Time in 12 hours
Display hours and minutes: hh:mm
Second in decimal
Horizontal tab

Display hours, minutes and seconds:
hh:mm:ss

Day of the week, Monday is the first day
(values from 0 to 6, Monday is 0)

Week of the year, with Sunday as the
first day (values from 0 to 53)

Week of the year, using a week-based
year

Day of the week in decimal (values from
0 to 6, 0 for Sunday)

Week of the year, with Monday as the
first day (values from 0 to 53)

Standard date string
Standard time string

Year in decimal without century (values
from 0 to 99)


https://wiki.dfrobot.com/Heart_Rate_Sensor_SKU__SEN0203
https://wiki.dfrobot.com/Self-Locking_Swicth_SKU__DFR0423
https://wiki.dfrobot.com/Heart_Rate_Monitor_Sensor_SKU__SEN0213
https://wiki.dfrobot.com/Gravity__Hall_Angle_Sensor_SKU__SEN0221
https://wiki.dfrobot.com/Conductivity_Switch_Sensor_SKU__SEN0223
https://wiki.dfrobot.com/Incremental_Photoelectric_Rotary_Encoder_-_400P_R_SKU__SEN0230
https://wiki.dfrobot.com/EC11_Rotary_Encoder_Module_SKU__SEN0235
https://wiki.dfrobot.com/Analog_EMG_Sensor_by_OYMotion_SKU_SEN0240
https://wiki.dfrobot.com/Gravity__Analog_Sound_Level_Meter_SKU_SEN0232
https://wiki.dfrobot.com/Air_Quality_Monitor__PM_2.5,_Formaldehyde,_Temperature_&_Humidity_Sensor__SKU__SEN0233
https://wiki.dfrobot.com/FireBeetle_Covers-OSD_Character_Overlay_Module_SKU_DFR0515
https://wiki.dfrobot.com/Gravity__Water_Pressure_Sensor_SKU__SEN0257
https://wiki.dfrobot.com/Gravity_Digital_Shake_Sensor_SKU_SEN0289
https://wiki.dfrobot.com/Gravity_Lightning_Sensor_SKU_SEN0290
https://wiki.dfrobot.com/GMR_Board_SKU_DFR0271_
https://wiki.dfrobot.com/Pirate_4WD_Mobile_Platform_SKU_ROB0003
https://wiki.dfrobot.com/Turtle_2WD_Mobile_Platform_SKU_ROB0005
https://wiki.dfrobot.com/NEW_A4WD_Mobile_Robot_with_encoder__SKU_ROB0025_
https://wiki.dfrobot.com/4WD_MiniQ_Complete_Kit__SKU_ROB0050_
https://wiki.dfrobot.com/4WD_MiniQ_Cherokey__SKU_ROB0111_
https://wiki.dfrobot.com/6_DOF_Robotic_Arm_Kit_SKU__ROB0036
https://wiki.dfrobot.com/DF05BB_Tilt_Pan_Kit__SKU_FIT0045_
https://wiki.dfrobot.com/Cherokey_4WD_Mobile_Platform__SKU_ROB0102_
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https://wiki.dfrobot.com/4WD_Mobile_Platform_SKU_ROB0022
https://wiki.dfrobot.com/Basic_Kit_for_Turtle_2WD_SKU_ROB0118
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ROBO0128 Devastator Tank Mobile
Platform Metal DC Gear Motor

ROBO0137 Explorer MAX Robot
ROBO0139 FlameWheel Robot
DFR0270 Accessory Shield for Arduino

DFR0019 Prototyping Shield For
Arduino

DFR0265 IO Expansion Shield for
Arduino V7

DFR0210 Bees Shield

DFR0165 Mega IO Expansion Shield
V2.3

DFRO0312 Raspberry Pi GPIO Extension
Board

DFRO0311 Raspberry Pi Meet Arduino
Shield

DFR0327 Arduino Shield for Raspberry
Pi2B and 3B

DFRO0371 IO Expansion Shield for
Bluno M3

DFR0356 Bluno Beetle Shield

DFR0412 Gravity 10 Expansion Shield
For DFRduino M0

DFR0375 Cookie I O Expansion Shield
V2

DFR0334 GPIO Shield for Arduino
V1.0

DFRO0502 Gravity IO Expansion &
Motor Driver Shield V1.1

DFR0518 Micro Mate- A Mini
Expansion Board for micro bit

DFR0578 Gravity I O Expansion Shield
for OpenMV Cam M7

DFRO0577 Gravity I O Expansion Shield
for Pyboard

DFR0626 MCP23017 IIC to 16 digital
IO expansion module
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Formatting

Output
characters P
%Y Year in decimal with century
Time zone name, or return null if no
%z

time zone name is available

8.4 Get the weather with WIFI

This example is used to let you learn how to get weather
information and let you experience the information obtained
in HTTP which extract data through Json and print it

e Before burning the code, we perform the following steps

1.You need to install the Arduino_JSON library. Enter
Arduino_JSON in Arduino IDE Tools -> Manage Libraries and
install the library

@ Library Manager X
Type All ~ Topic AL ~ | Arduine_JSON
Arduine_JSOF ~

by Arduino Varsion 0.1.0 TNSTALLED
[BETA] Process JSON in your Arduino sketches.
Mars infa

C++. Arduinolson supports ¥ v v
+ streams, ¥ filtering, and more. It is the most popular Arduins library on
a

rary for
M n, ¥ zero-copy,
GitHub ¥¥¥¥¥. Chack out : for
Mors info

2.Register an OpenWeather account to get the weather
information we want. Open your browser and go to
https://openweathermap.org/appid/ press the sign up button
and create a free account.
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Click My API Keys to enter the interface for obtaining API
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https://wiki.dfrobot.com/GPIO_Shield_for_Arduino_V1.0_SKU__DFR0334
https://wiki.dfrobot.com/Gravity_IO_Expansion_&_Motor_Driver_Shield_V1.1_SKU__DFR0502
https://wiki.dfrobot.com/Micro_Mate-_A_Mini_Expansion_Board_for_micro_bit_SKU__DFR0518
https://wiki.dfrobot.com/Gravity__I_O_Expansion_Shield_for_OpenMV_Cam_M7_SKU_DFR0578
https://wiki.dfrobot.com/Gravity__I_O_Expansion_Shield_for_Pyboard_SKU_DFR0577
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DFR0287 LCD12864 Shield

DFR0009 LCD KeyPad Shield For
Arduino

DFR0063 [2C TWI LCD1602 Module
Gadgeteer Compatible

DFRO0154 12C TWI LCD2004 Module
Arduino Gadgeteer Compatible

DFR0202 RGB LED Matrix
DFR0090 3-Wire LED Module

TOYO0005 OLED 2828 color display
module .NET Gadgeteer Compatible

TOY0006 OLED 9664 RGB Display
module

TOY0007 OLED 2864 display module

FIT0328 2.7 OLED 12864 display
module

DFRO0091 3-wire Serial LCD Module
Arduino Compatible

DFR0347 2.8 TFT Touch Shield with
4MB Flash for Arduino and mbed

DFRO0348 3.5 TFT Touch Shield with
4MB Flash for Arduino and mbed

DFR0374 LCD Keypad Shield V2.0
DFR0382 LED Keypad Shield V1.0

DFR0387 TELEMATICS 3.5 TFT
Touch LCD Shield

DFR0459 8x8 RGB LED Matrix

DFR0460 64x32 RGB LED Matrix -
4mm Pitch/64x32 Flexible RGB LED
Matrix-4mm Pitch/64x32 Flexible RGB
LED Matrix-5Smm Pitch

DFR0461 Gravity Flexible 8x8 RGB
LED Matrix

DFR0462 Gravity Flexible 8x32 RGB
LED Matrix

DFR0463 Gravity Flexible 16x16 RGB
LED Matrix

DFR0471 32x16 RGB LED Matrix -
6mm pitch

DFR0472 32x32 RGB LED Matrix -
4mm pitch

DFR0464 Gravity 12C 16x2 Arduino
LCD with RGB Backlight Display
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Copy the key here (this key is your only key to get weather
information from OpenWeather)
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You can fill the Key into the following URL and fill in the city
name and its country to get the city weather information
http://api.openweathermap.org/data/2.5/weather?
g=yourCityName,yourCountryCode&APPID=yourAPlkey The
following is an example to replace the city (such as Chengdu)
of the data you want in yourCityName, yourCountryCode
and the country code of the city (such as CN), fill in
yourAPlkey which is the API key obtained earlier, the
following is the URL of Chengdu, China with the API added:
http://api.openweathermap.org/data/2.5/weather?
g=ChengDu,CN&APPID=4de305d0a52ddaceaecba50a757e
9968 Copying your URL into your browser will return a set of
information corresponding to your local weather. On the day
this tutorial was written, we had the following information
about the weather in Chengdu, China.
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DFR0499 64x64 RGB LED Matrix -
3mm pitch

DFR0506 7" HDMI Display with
Capacitive Touchscreen

DFRO555\DF0556\DFR0557 Gravity
[2C LCD1602 Arduino LCD Display
Module

DFR0529 2.2 inches TFT LCD Display
V1.0 (SPI Interface)

DFRO0605 Gravity: Digital RGB LED
Module

FIT0352 Digital RGB LED
Weatherproof Strip 60LED m*3m

DFR0645-G DFR0645-R 4-Digital
LED Segment Display Module

SKU DFR0646-G DFR0646-R 8-
Digital LED Segment Display Module

DFRO0597 7x71 Flexible RGB LED
Matrix

DFR0231 NFC Module for Arduino
TELO0005 APC220 Radio Data Module
TEL0023 BLUETOOH BEE

TEL0026 DF-BluetoothV3 Bluetooth
module

TEL0037 Wireless Programming
Module For Arduino

TEL0044 DFRduino GPS Shield-LEA-
S5H

TELO0047 WiFi Shield V2.1 For Arduino

TEL0051 GPS GPRS GSM Module
V2.0

TEL0067 WiFi Bee V1.0
TEL0073 BLE-Link
TELO0075 RF Shield 315MHz

TELO0078 WIFI Shield V3 PCB
Antenna

TEL0079 WIFI Shield V3 RPSMA
TEL0084 BLEmicro
TEL0086 DF-Beacon EVB

TEL0087 USBBLE-LINK Bluno
Wireless Programming Adapter

TEL0080 UHF RFID MODULE-USB

TEL0081 UHF RFID MODULE-
RS485
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""coord"'{”l ”'104 0667, "at": 0. 66671, “veather”

[{id":804, "main”:"Clouds’, deﬂu " ovelca@t

tlod L”,”lcon” W'Y base tauonﬂ

e 290,86, "Teels hle 0.7 Temp min’ 290 86, "temp nax”:290.86, "pre
ssure” 1014, "midity":78, s 1 1'104 and level 957}, "visihility":1
0000, "wind": {"speed”:0.51, d "9 "aust”0, 361, "clouds”:

Call' 94* It 1633655120

Coomtry: OV "sunrise” 1633()%6‘4, "Sunset”: 16336806691, "tinezone”: 29500
" 181&80, “nane” Chengdu”, "cod”: 200}

Code

/*
This example learns how to get weather information
*/

#include <WiFi.h>
#include <HTTPClient.h>
#include <Arduino_JSON.h>

//Modify WIFI name and password
const char* ssid = "¥¥*x**" //WIFI name
const char* password = "¥¥¥**x" //WIFT password

//Fill in the API Key you got

String openWeatherMapApiKey = "4de305d@a52ddaceaect
//Example:

//String openWeatherMapApiKey = "4de3@5d@a52ddaceae

// Fill in your city name and country abbreviation
String city = "ChengDu";
String countryCode = "CN";

//Example:
//String city = "ChengDu";
//String countryCode = "CN";

//Set the interval for obtaining information, the f
//You should 1limit the minimum interval of access t
unsigned long lastTime = O;

//Set to get weather data every 10 minutes
//unsigned long timerDelay = 600000;

//Set to get weather data every 10 seconds

unsigned long timerDelay = 10000;

String jsonBuffer;

void setup() {
Serial.begin(115200);
WiFi.begin(ssid, password);
Serial.println("Connecting");

//Determine if WIFI is connected
while(WiFi.status() != WL_CONNECTED) {
delay(500);
Serial.print(".");
¥
Serial.println("");
Serial.print("Connected to WiFi network with IP A
Serial.println(WiFi.localIP());
Serial.println("Timer set to 10 seconds (timerDel
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TEL0082 UHF RFID MODULE-
UART

TELO0083-A GPS Receiver for Arduino
Model A

TEL0092 WiFi Bee-ESP8266 Wirelss
module

TEL0094 GPS Module With Enclosure

TEL0097 SIM808 GPS GPRS GSM
Shield

DFR0342 W5500 Ethernet with POE
Mainboard

DFRO0015 Xbee Shield For Arduino no
Xbee

TELO0107 WiFiBee-MT7681 Arduino
WiFi Wireless Programming

TEL0089 SIM800C GSM GPRS Shield
V2.0

TELO0112 Gravity 315MHZ RF Receiver
Module

TELO113 Gravity UART A6 GSM &
GPRS Module

TELO118 Gravity UART OBLOQ IoT
Module

TEL0120 DFRobot BLE4.1 Module
TEL0002 Bluetooth Adapter

TEL0108 Bluetooth Audio Receiver
Module

TEL0124 SIM7600CE-T 4G(LTE)
Shield V1.0

DFR0505 SIM7000C Arduino NB-IoT
LTE GPRS Expansion Shield

DFRO0013 IIC to GPIO Shield V2.0

DFRO0057 Sensor Motor Drive Board -
Version 2.2

DFR0062 WiiChuck Adapter
DFR0233 RS485 Sensor Node V1.0
DFR0259 Arduino RS485 Shield
DFR0370 CAN-BUS Shield V2
DFR0627 IIC to dual UART module

TELO0070 Multi USB RS232 RS485
TTL Converter

DFR0064 386 AMP audio amplifier
Module

DFR0273 Speech Synthesis Shield

NERQ NED s D dini
Downloaded from Arrow.com.

void loop() {

//Send HTTP get request
if ((millis() - lastTime) > timerDelay) {
//Check if WIFI is connected
if(WiFi.status()== WL_CONNECTED){
String serverPath = "http://api.openweathermz

//Put the combined URL into the httpGETReques
jsonBuffer = httpGETRequest(serverPath.c_str(
Serial.println(jsonBuffer);

//Store the parsed Json object value in the J
JSONVar myObject = JSON.parse(jsonBuffer);

//Determine if the parsing was successful
if (JSON.typeof(myObject) == "undefined") {
Serial.println("Parsing input failed!");

return;

Serial.print("JSON object = ");
Serial.println(myObject);
Serial.print("Temperature: ");
//The obtained temperature is actually Kelvir
//Kelvin = Celsius + 273.15
double ¢ = myObject["main"]["temp"];
c = c-273.15;
Serial.println(c);
Serial.print("Pressure: ");
//myObject["main"]["pressure"], the front is
Serial.println(myObject["main"]["pressure"]);
Serial.print("Humidity: ");
Serial.println(myObject["main"]["humidity"]);
Serial.print("Wind Speed: ");
Serial.println(myObject["wind"]["speed"]);

}

else {

Serial.println("WiFi Disconnected");
¥
lastTime = millis();

String httpGETRequest(const char* serverName) {

WiFiClient client;
HTTPClient http;

//Connect URL
http.begin(client, serverName);

//Send HTTP site request
int httpResponseCode = http.GET();

//This array is used to store the obtained data
String payload = "{}";

//Put the obtained data into the array

if (httpResponseCode>0) {
Serial.print("HTTP Response code: ");
Serial.println(httpResponseCode);
payload = http.getString();

}

else {
Serial.print("Error code: ");
Serial.println(httpResponseCode);

}

//Release resources
http.end();

//Return the obtained data for Json processing
return payload;
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TOY0008 DFRduino Player MP3
SEN0197 Voice Recorder-ISD1820

DFR0420 Audio Shield For DFRduino
MO

DFR0534 Voice Module

SD2403 Real time clock Module SKU
TOY0020

TOY0021 SD2405 Real time clock
Module

DFRO151 Gravity 12C DS1307 RTC
Module

DFR0469 Gravity 12C SD2405 RTC
Module

DFR0316 MCP3424 18-Bit ADC-4
Channel with Programmable Gain

Amplifier

DFRO0552 Gravity 12-Bit 12C DAC
Module

DFRO0553 Gravity [2C ADS1115 16-Bit
ADC Module Arduino & Raspberry Pi

Compatible

DFRO117 Gravity I2C EEPROM Data
Storage Module

DFR0071 SD Module

DFRO0057 Sensor Motor Drive Board -
Version 2.2

DFR0360 XSP - Arduino Programmer

DFRO0411 Gravity 130 DC Motor

DFR0438 Bright LED Module

DFR0439 LED String Lights Colorful
DFR0440 The Micro Vibration Module

DFR0448 LED String Lights Warm
White

DFR0503 Embedded Thermal Printer -
TTL Serial

DFR0504 Gravity Analog Signal Isolator
DFRO0520 Dual Digital Pot 100K
DFRO0565 Gravity Digital Signal Isolator

DFR0563 Gravity 3.7V Li Battery Fuel
Gauge

DFRO0576 Gravity Digital 1-to-8 12C
Multiplexer

DFRO0117 Gravity [2C EEPROM Data
Storage Module
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Result

@ com3 — o X

Connected to WiFi network with IP Address: 192.168.1.2
Timer set to 10 seconds (timerDelay variable), it will take 10 seconds
HTTP Response code: 200

JSON object =
Temperature: 18.56
HTTP Response code: 200

JSON object =
Temperature: 19.94
Pressure: 1015
Humidity: 77

wind Speed: 1

HTTP Response code: 200

v
< >
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Member function

o httpGETRequest(serverPath.c_str());
Description: Parse the obtained object

e JSON.typeof(myObject)
Description: Determine whether the object is in a
parsed format

8.5 SmartConfig One-click network
configuration + automatic reconnection

Through this code, Espressif's ESP-TOUCH can be used for
one-click network configuration. Click to download the
Android version For I0S version, please search for Espressif
Esptouch in the App Store

#include <WiFi.h>

void SmartConfig()
{
WiFi.mode(WIFI_STA);
Serial.println("\r\nWait for Smartconfig...");
WiFi.beginSmartConfig();
while (1)
{
Serial.print(".");
delay(500); // wait for a sec
if (WiFi.smartConfigDone())
{
Serial.println("SmartConfig Success");
Serial.printf("SSID:%s\r\n", WiFi.SSID().c_st
Serial.printf("PSW:%s\r\n", WiFi.psk().c_str(
break;

bool AutoConfig()
{
WiFi.begin();
for (int 1 = 0; i < 20; i++)
{
int wstatus = WiFi.status();
if (wstatus == WL_CONNECTED)
{
Serial.println("WIFI SmartConfig Succes
Serial.printf("SSID:%s", WiFi.SSID().c_
Serial.printf(", PSW:%s\r\n", WiFi.psk(
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Serial.print("LocalIP:");
Serial.print(WiFi.localIP());
Serial.print(" ,GateIP:");
Serial.println(WiFi.gatewayIP());

DRI0001 Arduino Motor Shield 1.293

DRI0002 MD1.3 2A Dual Motor

Controller AT SRS
DRI0009 Arduino Motor Shield L298N lee
{
91 Vevron 2x2 g >
II\D/IRIO(‘)I“)] .Vt?llon 2x25A Brush DC Serial.print("WIFI AutoConfig Waiting..
n A Serial.println(wstatus);

. . delay(1000);

DRI0017 2A Motor Shield For Arduino }

Twin

}
Serial.println("WIFI AutoConfig Faild!" );

DRI0018 DC Motor Driver 2x15A Lite .
return false;

FIT0450 Micro DC Motor with

Encoder-SJO1 void setup() {

Serial.begin(115200);
delay(100);

if (!AutoConfig())

{

FIT0458 Micro DC Motor with
Encoder-SJ02

DFR0399 DC Micro Metal Gear Motor .

- . SmartConfig();
75 1 w Driver

DRI0039 Quad Motor Driver Shield for

Arduino void loop() {

DRI0040 Dual 1.5A Motor Driver -

HR8833 J

1 | 2
DRI10044 2x1.2A DC Motor Driver
TB6612FNG FAQ

DFRO0513 PPM 2x3A DC Motor Driver

, N Burning error
DFR0523 Gravity Digital Peristaltic

Pump Reason

DRI0027 Digital Servo Shield for e If the delay is too short or no delay is added in the loop,
Arduino N . .
it will cause the programming to time out.

Gamet el et e el
Channel

SER0044 DSS-M15S 270° 15KG DF e (Calling some functions incorrectly can cause the

Metal Servo with Analog Feedback computer to fail to recognize the USB.

DRI10023 Stepper Motor Shield For
Arduino DRV8825

DRI0035 TMC260 Stepper Motor

Driver Shield USB device not recognized

The last USB device you connected to

this computer malfunctic

DFRO0105 Power Shield

Windows does not recog

DFR0205 Power Module 10:24 AM

Az B 505

DFR0457 Gravity MOSFET Power )
Controller Resolutions

DFRO0564 USB Charger for 7.4V LiPo e Connect pin 9 to GND and pull down, power on again,
Battery and burn again

DFRO0535 Solar Power Manager

Serial port does not print

DFR0559 Sunflower Solar Power
Manager 5V

Resolutions

~ o Check if USB CDC is in Enable state
DFRO0559 Solar Power Manager 5V

e Use other serial debugging assistants to view print

DFR0580 Solar Power Manager For information
Downloaded from Arrow.com.
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For any questions, advice or cool ideas to share, please visit
DFR0222 X-Board Relay the DFRobot Forum.

DFR0017 Relay Module Arduino
Compatible

More Documents

DFR0289 RLY-8-POE Relay Controller e ESP32-C3-mini-1 Datasheet

e Schematics Diagram

DFR0290 RLY-8-RS485 8 Relay
Controller

e Dimension Diagram

DFR0144 Relay Shield for Arduino \E’ Get Beetle ESP32 C3 from DFRobot Store or DFRobot
V2.1 Distributor.

DFRO0473 Gravity Digital Relay Module Turn to the Top
Arduino & Raspberry Pi Compatible
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